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Capitolo 1: Introduzione

In questo capitolo

Questa guida per l'utente descrive come utilizzare MediByte, MediByte Jr e il software 
MediByte allegato. La guida per l'utente è composta da nove capitoli:

1. Introduzione

2. Specifiche

3. Installazione del software

4. Preparazione di MediByte per uno studio

5. Preparazione del paziente

6. Revisione dei dati

7. Gestione dei dati

8. Password, display e manutenzione

9. Trasferimento di file e segnalazione a distanza

In questo capitolo vengono descritti MediByte, MediByte Jr e i loro accessori. Il capitolo 
comprende:

• Novità di MediByte Software 9.0

• Uso previsto

• Convenzioni utilizzate in questa guida

• Avvertenze e precauzioni

• Contenuto del Kit MediByte e del Kit MediByte Jr

• Panoramica di MediByte e MediByte Jr
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Introduzione
Novità di MediByte Software 9.0
• Un programma software per MediByte e MediByte Jr.

• Compatibilità con Windows 10 e 11.

• Miglioramento della sicurezza e della registrazione operativa.

• Registrare un canale del sonno che visualizza le forme d'onda EEG, EOG ed EMG sul display dei dati.

• Sonno + Montaggio della raccolta EEG.

• Sonno + Montaggio della raccolta ECG.

• AHI, RDI sullo schermo.

• Possibilità di aggiungere manualmente i tag di segnalazione della fase del sonno alla visualizzazione 
dei dati.

• Ipnogramma della fase del sonno tracciato in tempo reale, mentre i dati sono segnalati dalla fase del 
sonno.

• Marcatura manuale delle ipopnee centrali e degli eventi della respirazione di Cheynes Stokes.

• Marcatura manuale dei risvegli trascinando il mouse sulla forma d'onda dell'EEG.

• Opzione di larghezza di visualizzazione di dieci minuti.

• Vista del fotopletismografo (segnale PPG) nella parte inferiore della visualizzazione dei dati.

• Marcatura e segnalazione della variabilità della frequenza del polso.

• Misure metriche nella configurazione guidata.

• Possibilità di cambiare i RERA segnalati automaticamente in RERA�Sub-ipopnee segnalati 
automaticamente.

• Ora il data manager degli studi ha una funzione di ordinamento. Ordinare per nome del paziente, 
data dello studio e tipo di registratore.

• Il data manager degli studi mostra il valore di AHI, RDI e dei dati validi in uno studio.

• Possibilità di modificare e spostare le forme d'onda.

• Per i report non è più necessario Excel; gli aggiornamenti comprendono la frequenza respiratoria; 
le statistiche SpO2 con e senza desaturazioni.

• Vista di AHI, RDI e del numero di minuti di dati validi nella barra di stato dello studio.

• Ora MediByte e MediByte Jr possono lavorare con i dispositivi PAP bi-livello.

• Lo studio si è dimostrato NON VALIDATO (segnalato solo da algoritmi di segnalazione assistita) o 
VALIDATO (segnalato da una persona addestrata).

• Gli eventi possono essere segnalati solo nelle fasi non di veglia.

• I valori di AI, AHI, RDI e Dati validi nella barra di stato vengono aggiornati in tempo reale mentre 
l'utente valuta lo studio.

• L'utente può passare con il mouse su qualsiasi forma d'onda e vedere i dati effettivi della forma 

d'onda nella barra di stato.



Introduzione
Uso previsto

Popolazione di riferimento: Bambini e pazienti adulti che vengono sottoposti a screening 
durante gli studi sui disturbi del sonno.

Ambiente di utilizzo: La maggior parte degli screening avviene a domicilio o in un ambiente 
clinico (laboratorio del sonno).

Indicazioni

Controindicazioni

MediByte è un registratore portatile di dati relativi al sonno utilizzato per registrare i segnali 
fisiologici durante il sonno, mentre il paziente si trova a casa o in un ambiente clinico. I dati 
vengono scaricati al termine della registrazione e il software di assistenza automatica consente 
al professionista umano addestrato - in genere uno Specialista del sonno abilitato o un Medico 
- di rivedere e verificare i risultati dello studio e di generare un report.

MediByte è un dispositivo per il sonno utilizzato per diagnosticare i disturbi del sonno, come 
l'apnea notturna, la resistenza delle vie aeree superiori, il russamento, i movimenti periodici 
degli arti, il bruxismo.

Questo prodotto è solo per scopi diagnostici e non deve essere usato come monitor per l'apnea 
o in applicazioni di supporto o sostegno vitale.
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Introduzione
Simboli utilizzati sul dispositivo e guide

Simboli per MediByte e MediByte Jr

Parte applicata di tipo BF: parte applicata di tipo F conforme ai requisiti 
specificati della norma IEC 60601-1, per un grado di protezione superiore 
contro le scosse elettriche rispetto a quello delle parti applicate di tipo B.

Le parti applicate di tipo BF non sono adatte all'applicazione cardiaca diretta.

Numero catalogo�numero di riferimento.

Numero di serie del dispositivo.

Dispositivo medico.

Prodotto in Canada.

Informazioni del produttore.

Leggere il manuale dell'operatore.

Questi  simboli sono utilizzati su MediByte e MediByte Jr, o sulle etichette della confezione. Nella 
tabella riportata qui di seguito sono elencati il simbolo, il nome o il significato del simbolo.



Introduzione
Consultare le istruzioni per l'uso.

Limite temperatura di funzionamento.

Limite umidità di funzionamento.

Conservare in luogo asciutto.

Limite temperatura per il trasporto e la conservazione.

Limite umidità per il trasporto e la conservazione.

IP22

Rappresentante autorizzato nella Comunità Europea.

Marcatura di conformità del Regno Unito.

In conformità alla direttiva europea sui rifiuti da apparecchiature elettriche 
ed elettroniche (RAEE) 2002�96�CE, non smaltire questo prodotto come 
rifiuto urbano indifferenziato.

Protezione ingresso: l'IP22, come definito dalla norma IEC 60529, è protetto 
dal contatto con le dita e da oggetti di diametro superiore a 12,5 mm, da 
spruzzi di liquidi a meno di 15 gradi dalla verticale.
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Introduzione
Convenzioni relative alle Guide per l'utente e per il paziente
Di seguito sono riportate le convenzioni relative ai documenti e alla sicurezza.

Avvertenza: Questo simbolo segnala un'avvertenza importante. 
È fondamentale prestare attenzione a tutte le avvertenze per 
evitare lesioni a sé stessi o al paziente.vital that you 

Precauzioni: Questo simbolo segnala una precauzione. Seguire 
tutte le precauzioni per evitare danni all'apparecchiatura.

Nota: Questo simbolo segnala una nota. Le note forniscono 
informazioni importanti sull'uso di MediByte/MediByte Jr, dei suoi 
accessori e del software.

Proteggere dal calore e da fonti radioattive.

Conservare in luogo asciutto.

Niente smalto per le unghie.



Introduzione
Avvertenze e precauzioni

Questo prodotto è solo per scopi diagnostici e NON deve essere usato come monitor per l'apnea 
o in applicazioni di supporto o sostegno vitale.

Avvertenze

• MediByte�MediByte Jr registrano segnali da utilizzare nella valutazione dei disturbi del sonno. 
Accertarsi che tutti gli studi siano rivisti da una persona qualificata. Un medico abilitato è tenuto, 
per legge, a diagnosticare l'apnea del sonno perché si tratta di un problema medico.

• Per proteggere il paziente, non collegare mai MediByte�MediByte Jr al computer mentre il paziente 
è ancora collegato a MediByte�MediByte Jr.

• Utilizzare sempre una cannula BRAEBON e un filtro idrofobico (di sicurezza) BRAEBON nuovi per 
ogni paziente.

• NON usare o tentare di riparare parti danneggiate.

• L'apertura non autorizzata di MediByte�MediByte Jr annullerà la sicurezza di MediByte�MediByte Jr 
oltre ai termini e alle condizioni della garanzia MediByte. Non è consentita alcuna modifica di 
questa apparecchiatura.

• Non modificare questa apparecchiatura senza l'autorizzazione del produttore.

• Se questa apparecchiatura viene modificata, è necessario eseguire ispezioni e test appropriati per 
garantirne un uso continuativo e sicuro.

• Tenere MediByte�MediByte Jr e i suoi componenti lontano dalle fiamme.

• NON utilizzare MediByte�MediByte Jr in presenza di composti infiammabili come anestetici.

• NON immergere MediByte�MediByte Jr in liquidi per evitare di danneggiarli. Avvisare tutti i pazienti di 
tenere MediByte�MediByte Jr lontano dall'acqua. I danni provocati dall'acqua annullano la garanzia.

• NON sterilizzare MediByte�MediByte Jr.

• NON eseguire studi del sonno senza sorveglianza su pazienti che non sono fisicamente in grado di 
utilizzare MediByte e i suoi accessori.

• Per evitare lo strangolamento, accertarsi che tutti i cavi e le terminazioni siano fissati con nastro 
adesivo.

• L'applicazione di una sonda SpO2 con una pressione eccessiva per periodi prolungati può provocare 
lesioni da pressione.

• Le parti conduttive degli elettrodi e dei connettori associati alle parti applicate, tra cui l'elettrodo 
neutro, non devono entrare in contatto con altre parti conduttive, tra cui la terra.

• MediByte non deve essere utilizzato insieme a strumenti chirurgici HF.

• Accertarsi che il sensore SpO2 non sia troppo stretto. L'applicazione errata di una sonda 
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Introduzione
Avvertenza batteria Saft LS14250:

Avvertenza sulla batteria BRAEBON ricaricabile:

• Il sensore SpO2 non contiene allarmi.

• Indossare MediByte o MediByte Jr sopra gli indumenti per ridurre il rischio di reazioni allergiche.

• Non tentare di ricaricare la batteria Saft LS14250.

• La batteria deve essere sostituita solo da personale qualificato.

• Rimuovere la batteria se il dispositivo non viene utilizzato per un periodo prolungato.

• Rischio di incendio, esplosione e gravi ustioni. Non ricaricare, cortocircuitare, schiacciare, disassemblare, 
riscaldare a una temperatura superiore a 100 °C (212 °F), bruciare o esporre i contenuti all'acqua.

• La batteria deve essere sostituita solo da personale qualificato.

• Rimuovere la batteria se il dispositivo non viene utilizzato per un periodo prolungato.

• Rischio di incendio, esplosione e gravi ustioni. Non cortocircuitare, schiacciare, disassemblare, 
riscaldare al di sopra dei 100 °C (212 °F), bruciare o esporre i contenuti all'acqua.



Introduzione
Condizioni di 
funzionamento

Condizioni di 
conservazione e trasporto

Temperatura 010 C–35 C C–50 C

Umidità relativa 30%–95% 
(Senza condensa) 10%–100%

Precauzioni

• Utilizzare esclusivamente sensori e accessori BRAEBON.

• Utilizzare esclusivamente le bande BRAEBON (modelli 8572, 8572PED, 8574). Altre bande NON 
funzioneranno con MediByte.

• Utilizzare sempre una nuova cannula e un filtro idrofobico (di sicurezza) BRAEBON per ogni 
paziente.

• La sterilizzazione di MediByte NON è necessaria. NON sterilizzare MediByte in autoclave a vapore, 
per evitare di danneggiarlo e invalidare la garanzia.

• NON immergere MediByte in liquidi per non danneggiarlo. Avvisare tutti i pazienti di tenere 
MediByte lontano dall'acqua; i danni provocati dall'acqua annullano la garanzia.

• NON far cadere MediByte.

• Usare esclusivamente una batteria 1�2AA da 3,6 V, modello Saft LS14250 (0410) o una batteria 
ricaricabile agli ioni di litio 1�2AA (Modello 0412) fornita da BRAEBON.

• NON ricaricare la batteria Saft LS14250 (modello 0410); non è ricaricabile.

• Accertarsi che la polarità della batteria sia corretta al momento dell'inserimento; in caso contrario, 
il dispositivo non funzionerà.

• Utilizzare e conservare MediByte nelle seguenti condizioni ambientali:
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Introduzione
Contenuto del kit MediByte

Contenuto del kit MediByte

Il kit di batterie ricaricabili è un componente aggiuntivo disponibile. Vedere pagina 1-12 per l'elenco 
dei contenuti.

Quantità Articolo

1 Registratore MediByte (Modello MP-8)

2 Banda RIP per MediByte (Modello 8572)

1 Kit di preparazione per elettrodi MediByte (Modello 8128)

1 Kit di preparazione per elettrodi MediByte - cinque pezzi (Modello 8128-5)

6 Elettrodi autoadesivi, striscia da 5 (Modello 8501-5)

1 Microfono Ultima Snore per MediByte con ingresso a termistore (Modello 8541)

1 Scatola elettrodi (Modello 8611)

1 Kit terminazioni cavi per MediByte (Modello 8620)

1 Termistore per cannula cTherm (Modello 8514)

1 Cavo SpO2 per MediByte, punta morbida (Modello 8900)

1 Custodia per il trasporto di MediByte

1 Cavo USB per MediByte (Modello 8890)

1 Guide Medibyte per il paziente (Modello 8940)

1 Manuale d'uso per MediByte�MediByte Jr (installato con il software)

1 Cacciavite esagonale per MediByte (Modello 8870)

1 Guida alla configurazione di MediByte�MediByte Jr per il primo paziente

Verificare di aver ricevuto gli articoli elencati nel kit MediByte e che non siano stati danneggiati 
durante la spedizione. Se alcuni articoli sono danneggiati o mancanti, contattare immediatamente 
BRAEBON al numero 1.888.462.4841. NON utilizzare articoli danneggiati.



Introduzione
Contenuto del kit MediByte Lite

Contenuto del kit MediByte Lite

Il kit di batterie ricaricabili è un componente aggiuntivo disponibile. Vedere pagina 
1-12 per l'elenco dei contenuti.

Quantità Articolo

1 Registratore MediByte (modello MP-8)

2 Banda RIP per MediByte (modello 8572)

1 Kit paziente MediByte (modello 8110)

1 Kit paziente MediByte - cinque pezzi (modello 8110-5)

1 Cavo SpO2 per MediByte, punta morbida (Modello 8900)

1 Custodia per il trasporto di MediByte

1 Cavo USB per MediByte (modello 8890)

1 Guide per il paziente MediByte (modello 8940)

1 Manuale d'uso di MediByte�MediByte Jr (installato con il software)

1 Cacciavite esagonale per MediByte (modello 8870)

1 Guida alla configurazione di MediByte�MediByte Jr per il primo paziente

Verificare di aver ricevuto gli articoli elencati nel kit MediByte e che non siano stati danneggiati 
durante la spedizione. Se alcuni articoli sono danneggiati o mancanti, contattare 
immediatamente BRAEBON al numero 1.888.462.4841. NON utilizzare articoli danneggiati.
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Introduzione
Contenuto del kit MediByte Jr
Verificare di aver ricevuto gli articoli elencati nel kit MediByte Jr e che non siano stati 
danneggiati durante la spedizione. Se alcuni articoli sono danneggiati o mancanti, contattare 
immediatamente BRAEBON al numero 1.888.462.4841. NON utilizzare articoli danneggiati.

Contenuto del kit MediByte Jr

Il kit di batterie ricaricabili è un componente aggiuntivo disponibile.

Kit caricabatterie (Modelli 0444-N.A., 0445-E.U.)

Quantità Articolo

1 Registratore MediByte Jr (modello MBJR)

1 Banda RIP per MediByte (modello 8572)

1 Cavo SpO2 per MediByte, punta morbida (Modello 8900)

1 Kit paziente (Modello 8110)

1 Custodia per il trasporto di MediByte Jr

1 Cavo USB per MediByte (Modello 8890)

1 Guida MediByte Jr per il paziente (Modello 8926)

1 Manuale d'uso per MediByte�MediByte Jr (installato con il software)

1 Guida alla configurazione di MediByte�MediByte Jr per il primo paziente

Quantità Articolo

1
Kit caricabatterie per batterie al litio 1�2 AA (Modello 0429): contiene 
caricabatterie per batterie 1�2 AA (Modello 0422) e batterie al litio 
1�2 AA - confezione da 2 (Modello 0412-2)

1 di

Adattatore di alimentazione AC�DC, 12 V, 0,5 A, Europa, tipo C 
(Modello 0426)

Adattatore di alimentazione AC�DC, 12 V, 0,5 A, Nord America, tipo A 
(Modello 0424)

Disponibile 
anche

Adattatore di alimentazione AC�DC, 12 V, 0,5 A, Regno Unito, tipo G 
(Modello 0428)



Introduzione
Componenti e accessori per MediByte (* disponibili, non nel kit)

Articolo Nome dispositivo Descrizione

8572
8572PED*
8574*

Bande RIP per MediByte, 
medie, piccole*, grandi* 
(MediByte� MediByte Jr)

Si inseriscono nelle porte del torace e dell'addome su MediByte, 
utilizzate per rilevare lo sforzo respiratorio.

8541
Microfono Ultima Snore per 
MediByte con ingresso a 
termistore (solo MediByte)

Si collega alla porta AUX di MediByte e serve a rilevare i suoni del 
russamento.

8611 Scatola elettrodi (solo 
MediByte)

Si collega alla porta AUX di MediByte, utilizzata per collegare gli 
elettrodi a MediByte.

8612* Scatola elettrodi SE (solo 
MediByte)

Si collega alla porta AUX di MediByte, utilizzata per collegare gli 
elettrodi a MediByte per i montaggi Sonno + ECG e Sonno + EEG.

8620 Kit terminazioni cavi per 
MediByte (solo MediByte)

Si inserisce nella scatola elettrodi di MediByte, con le terminazioni 
cavi per il collegamento degli elettrodi autoadesivi. Contiene nove 
terminazioni cavi: cinque terminazioni cavi da 24” e quattro 
terminazioni cavi da 60”.

8514
Termistore per cannula 
cTherm per MediByte (solo 
MediByte)

Si collega alla porta di ingresso bianca del microfono per il 
russamento o della scatola elettrodi; serve per misurare il flusso 
d'aria.

8896*
Cavo SpO2 per MediByte 
(MediByte�MediByte Jr)

Si collega alla porta SpO2 di MediByte, misura la saturazione di 
ossigeno nel sangue e il polso (tipo Flexiwrap).

8898*
Cavo SpO2 per MediByte, 
involucro morbido grande 
(MediByte�MediByte Jr)

Si collega alla porta SpO2 di MediByte, misura la saturazione 
dell'ossigeno nel sangue e il polso.

8899*
Cavo SpO2 per MediByte,
Lobo dell'orecchio
(MediByte�MediByte Jr)

Si collega alla porta SpO2 di MediByte, misura la saturazione 
dell'ossigeno nel sangue e il polso.

8900
Cavo SpO2 per MediByte,
Punta morbida 
(MediByte�MediByte Jr)

Si collega alla porta SpO2 di MediByte, misura la saturazione di 
ossigeno nel sangue e il polso (tipo proteggi dita in silicone 
Flexiwrap).

8890 Cavo USB per MediByte 
(MediByte�MediByte Jr)

Collega MediByte al computer; utilizzato per programmare 
MediByte per uno studio e per scaricare i dati.

8110-25* Kit paziente MediByte 
(MediByte�MediByte Jr)

Confezione contenente 25 pezzi ciascuno: cannula oronasale 
monouso 8597, nastro di carta.
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Introduzione
8115-25* Kit paziente MediByte 
(MediByte�MediByte Jr)

Confezione contenente 25 pezzi ciascuno: cannula oronasale 
monouso 8597, batteria al litio 3,6V 1�2 AA. (solo Nord America)

8119-25* Kit paziente MediByte 
(MediByte�MediByte Jr)

Confezione contenente 25 pezzi ciascuno: cannula oronasale 
monouso 8597, batteria al litio 3,6V 1�2 AA, nastro di carta. (solo 
Nord America)

8120-25* Kit paziente MediByte 
(MediByte�MediByte Jr)

Confezione contenente 25 pezzi ciascuno: Nastro per sonda 
Nonin Flexiwrap, batteria al litio 3,6 V 1�2 AA, cannula oronasale 
8597. Da utilizzare con il cavo SpO2 8896 per MediByte.
(solo Nord America)

8128-5 Kit di preparazione elettrodi 
MediByte (solo MediByte)

Confezione contenente 5 pezzi ciascuno: cannula oronasale 8597 
monouso, tamponi di preparazione per gli elettrodi e nastro di carta.

8128-20*
Kit di preparazione elettrodi 
MediByte (solo MediByte)

Confezione contenente 20 pezzi ciascuno: cannula oronasale 
8597 monouso, elettrodi autoadesivi (20x5), tamponi per 
elettrodi e nastro di carta. Non consigliato per MediByte Jr.

8129-20*
Kit di preparazione elettrodi 
MediByte (solo MediByte)

Confezione contenente 20 pezzi ciascuno: cannula oronasale 
8597 monouso, elettrodi autoadesivi (5x20), tamponi per 
elettrodi, nastro di carta, batteria al litio 1�2 AA. Non consigliato 
per MediByte Jr. (solo per il Nord America)

8130-20*
Kit di preparazione elettrodi 
MediByte (solo MediByte)

Confezione contenente 20 pezzi ciascuno: cannula oronasale 
monouso 8597, elettrodi autoadesivi (5x20), nastro di carta, 
batteria al litio 1�2 AA. Non consigliato per MediByte Jr.
(solo Nord America)

8501-5
Elettrodi autoadesivi 
Vermed
(solo MediByte)

Confezione contenente 5 pezzi ciascuno: elettrodi monouso da 
applicare al paziente per studi PLM, ECG, Brux e del sonno.

8870 Cacciavite esagonale per 
MediByte Cacciavite per stringere la vite del vano batteria.

Custodia per il trasporto Custodia per il trasporto di MediByte o MediByte Jr.

8920 Manuale d'uso per 
MediByte�MediByte Jr Guida utente per il medico (scaricata con il software).

8925�8940 Guida per il paziente Guida utente per il paziente.

Guida alla configurazione di 
MediByte�MediByte Jr per 
il primo paziente

Guida rapida per i nuovi utenti (medici).

Articolo Nome dispositivo Descrizione



Introduzione
Sintesi di MediByte e MediByte Jr

Descrizione di MediByte e MediByte Jr

MediByte è disponibile in due modelli: MediByte e MediByte Jr.

MediByte e MediByte Jr sono costituiti dai componenti principali indicati qui di seguito:

registratore MediByte
Il registratore MediByte ha una custodia in plastica con un pulsante Evento (Event) e un LED di 
stato (Status LED) sul lato anteriore. Nella parte superiore del registratore sono presenti una 
porta ausiliaria (AUX) per il volume del russamento o per i sensori ECG�EMG, una porta per la 

Medibyte e MediByte Jr sono stati progettati per un rapido passaggio dal medico al paziente. 
Il medico prepara il registratore per la raccolta dei dati con il MediByte Software in dotazione. 
Dopo la preparazione di MediByte (o MediByte Jr) da parte del medico, il paziente dorme con 
il dispositivo e lo restituisce al medico per il download e l'analisi dei dati. Il download e l'analisi 
dei dati vengono eseguiti con MediByte Software. Dopo aver esaminato i dati, il medico genera 
un report utilizzando il software.

MediByte e MediByte Jr sono dispositivi ambulatoriali compatti progettati per contribuire in 
modo efficace alla rilevazione di una serie di disturbi del sonno, come l'apnea, la resistenza 
delle vie aeree superiori e il russamento. Con le dimensioni ridotte e la facilità di trasporto, 
i medici non si devono più limitare a registrare i dati in un ambiente di sonno artificiale. La 
raccolta dei dati può avvenire nell'ambiente naturale del paziente per un periodo più lungo 
rispetto a quello di un laboratorio del sonno.

MediByte registra fino a 15 canali di segnali fisiologici: ossimetria; frequenza cardiaca; 
fotopletismografia; pressione (flusso); russamento (derivato dalla pressione); flusso termico; 
sforzo toracico RIP; sforzo addominale RIP; SUM (derivato); marcatore di eventi; posizione del 
corpo; EEG, EOG, EMG ed ECG (con AUX); o ECG, o EMG o audio del russamento (con AUX), 
livello sonoro; flusso CPAP e pressione CPAP.

MediByte Jr registra fino a sette canali di segnali fisiologici: ossimetria; frequenza cardiaca; 
pressione (flusso); russamento (derivato dalla pressione); sforzo toracico RIP; marcatore di 
eventi; posizione del corpo; flusso e pressione CPAP. MediByte Jr non dispone di una porta AUX.

• registratore MediByte�MediByte Jr

• cavo USB

• sensori BRAEBON

• MediByte Software.
  1-15

pressione e una porta SpO2. Sulla parte inferiore del registratore,
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è presente una porta di comunicazione, una porta toracica, una porta addominale e un 
interruttore di accensione�spegnimento della raccolta. Vedere la Figura 1.2 a pagina 1-17 
per la posizione delle porte.

Il pulsante Evento, situato sulla parte anteriore del 
registratore, consente al paziente di registrare un 
evento premendo il pulsante. Il marcatore dell'evento 
viene definito dal medico all'interno del software. Gli 
eventi più comuni sono lo spegnimento delle luci, 
l'accensione delle luci e la pausa bagno.

Il LED di stato è una piccola luce situata sulla parte 
anteriore del registratore; lampeggia in verde o in rosso 
per indicare lo stato attuale dell'unità. Per esempio, il 
LED lampeggia in verde una volta ogni sei secondi per 
indicare che il registratore è in attesa della raccolta dei 
dati; e lampeggia in verde due volte ogni sei secondi per 
indicare che il registratore sta raccogliendo i dati.
Il lampeggiamento rosso continuo indica che la batteria 
è molto scarica per registrare uno studio, anche se la 
carica residua potrebbe essere sufficiente per scaricare 
i dati. Vedere Display e indicatori a pagina 2-5 per un 
elenco completo degli indicatori LED di stato.

La porta ausiliaria (AUX), situata sulla parte superiore del registratore, consente di collegare a 
MediByte il microfono per il russamento (con o senza termistore) o una delle due versioni 
della Scatola elettrodi.

La porta per la pressione, situata sulla parte superiore del registratore, collega la cannula oronasale 
al registratore. Questa porta può essere utilizzata anche per registrare la pressione CPAP.

La Porta SpO2, situata nella parte superiore del registratore, collega il cavo SpO2 al registratore.

La Porta toracica collega la banda RIP per MediByte al registratore.

La Porta addominale collega la banda RIP per MediByte al registratore.

L'interruttore Raccolta On�off (Collection on�off) imposta l'unità per la registrazione quando è 

Figura 1.1: MediByte ACCENSIONE/
SPEGNIMENTO

La Porta di comunicazione, situata nella parte inferiore del registratore, accetta il cavo USB 
BRAEBON. Utilizzare questa porta per collegare il registratore al computer, configurare uno 
studio e scaricare i dati dal registratore. Non collegare mai l'unità al computer quando è già 
collegata al paziente.
in modalità manuale. Per avviare la registrazione, premere l'interruttore a destra (punto bianco). 
Questo interruttore funziona solo quando l'unità è stata preimpostata per la registrazione 
manuale nel software. L'interruttore di accensione�spegnimento della raccolta è disattivato se
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l'unità è preimpostata per la registrazione automatica all'interno del software. Si disattiva anche 
quando l'unità è collegata al computer.

Per ottimizzare le prestazioni e la facilità d'uso, BRAEBON consiglia la modalità automatica.

Figura 1.2: Posizioni delle porte MediByte

Porta spO2 Porta AUX

Porta pressione
Porta torace Porta addome

Porta di comunicazione Centro di raccolta 
  1-17
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Sensori BRAEBON

MediByte utilizza i sensori BRAEBON indicati qui di seguito:

• Due bande RIP per la banda MediByte (Modello 8572). Le bande RIP per MediByte si inseriscono nelle 
porte toraciche e addominali di MediByte. Le bande rilevano l'espansione e la contrazione dell'addome
e del torace (sforzo) e contribuiscono alla diagnosi di apnea notturna.

• Microfono Ultima Snore per MediByte (Modello 8541). Il microfono Ultima Snore per MediByte, che si 
collega alla porta AUX di MediByte, rileva i suoni del russamento.

• Una scatola elettrodi (Modello 8611). La scatola elettrodi che si collega alla porta AUX di MediByte, 
collega gli elettrodi a MediByte. Da usare per studi sul sonno, sull'ECG e sul bruxismo.

• Una scatola elettrodi SE (opzionale) (Modello 8612). La scatola elettrodi SE, che si collega alla porta AUX
di MediByte, collega gli elettrodi a MediByte. Utilizzarla per gli studi Sonno + ECG o Sonno + EEG.

• Un cavo SpO2 per MediByte (Modello 8900). Il cavo SpO2 per MediByte, che si collega alla porta SpO2 di 
MediByte, misura la saturazione di ossigeno nel sangue e il polso. Viene utilizzato come ausilio nella 
diagnosi dell'apnea notturna. Lo stato del segnale SpO2 può essere rivisto dopo aver effettuato il 
download dei dati.

• Una cannula oronasale (Modello 8597). La cannula oronasale, che si collega alla porta per la pressione d
MediByte, misura il flusso d'aria. Viene utilizzato come ausilio nella diagnosi dell'apnea notturna.

• Un termistore per cannula cTherm (Modello 8514). Il termistore per cannula cTherm, che si collega alla 
porta di ingresso bianca del microfono per il russamento (8541) o della scatola elettrodi (8611), misura 
flusso d'aria utilizzando dei termistori. Viene utilizzato come ausilio nella diagnosi dell'apnea notturna.
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Il registratore MediByte Jr
Il registratore MediByte Jr ha un involucro stampato in plastica con un LED di stato sulla parte 
anteriore. Sulla parte superiore del registratore sono presenti una porta per la pressione e 
una per la SpO2. Sulla parte inferiore del registratore sono presenti una porta di 
comunicazione, una porta toracica e un interruttore di accensione�spegnimento della 
raccolta. Vedere Figura 1.4 a pagina 1-20 per le ubicazioni delle porte.

Il LED di stato è una piccola luce situata sulla parte 
anteriore del registratore; lampeggia in verde o in rosso 
per indicare lo stato attuale dell'unità. Per esempio, il 
LED lampeggia in verde una volta ogni sei secondi per 
indicare che il registratore è in attesa della raccolta dei 
dati; e lampeggia in verde due volte ogni sei secondi per 
indicare che il registratore sta raccogliendo i dati.
Il lampeggiamento rosso continuo indica che la batteria 
è molto scarica per registrare uno studio, anche se la 
carica residua potrebbe essere sufficiente per scaricare 
i dati. Vedere Display e indicatori a pagina 2-5 per un 
elenco completo degli indicatori LED di stato.

La porta per la pressione, situata sulla parte superiore 
del registratore, collega la cannula oronasale al 
registratore. Questa porta può essere utilizzata anche 
per registrare la pressione CPAP.

La porta SpO2, situata sulla parte superiore del 
registratore, collega il cavo SpO2 al registratore.

La Porta di comunicazione, situata nella parte inferiore del registratore, accetta il cavo USB 
BRAEBON. Utilizzare questa porta per collegare il registratore al computer, configurare uno studio 
e scaricare i dati dal registratore. Non collegare mai l'unità al computer quando è già collegata al 
paziente.

La Porta toracica collega la banda RIP per MediByte al registratore.

L'interruttore Raccolta On�off imposta l'unità per la registrazione quando è in modalità manuale. 
Per avviare la registrazione, premere l'interruttore a destra (punto bianco). Questo interruttore 
funziona solo quando l'unità è stata preimpostata per la registrazione manuale nel software. 
L'interruttore di attivazione�disattivazione della raccolta è disabilitato se l'unità è preimpostata 

Figura 1.3: MediByte Jr
ACCENSIONE/
SPEGNIMENTO
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per la registrazione automatica all'interno del software. Si disattiva anche quando l'unità è 
collegata al computer.
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MediByte Jr utilizza i seguenti sensori BRAEBON:

MediByte Software

Figura 1.4: Posizioni delle porte MediByte Jr

• Una banda RIP per MediByte (Modello 8572). La banda RIP per MediByte si inserisce nella porta 
toracica di MediByte Jr. La banda rileva l'espansione e la contrazione del torace (sforzo) e 
contribuisce alla diagnosi di apnea notturna.

• Un cavo SpO2 per MediByte (Modello 8900). Il cavo SpO2 per MediByte, che si collega alla porta SpO2 
di MediByte Jr, misura la saturazione di ossigeno nel sangue e il polso. Viene utilizzato come ausilio 
nella diagnosi dell'apnea notturna.

• Una cannula oronasale (Modello 8597). La cannula oronasale, che si collega alla porta per la 
pressione di MediByte Jr, misura il flusso d'aria. Viene utilizzato come ausilio nella diagnosi 
dell'apnea notturna.

MediByte Software è il software progettato per il funzionamento esclusivamente con 
MediByte�MediByte Jr. Il software ha una comoda configurazione guidata che consente di 
configurare rapidamente il registratore per uno studio. Inserire il nome del paziente, l'ID del 
paziente, il peso del paziente e selezionare il tipo di studio che si desidera eseguire. Il software 
invia queste informazioni al registratore, indicandogli quali tipi di canali devono essere registrati 
e a chi associare i dati. Dopo il completamento dello studio da parte del paziente, eseguire il 
download dei dati dal registratore sul computer. Il software contribuirà all'analisi dei dati. Dopo 
aver esaminato l'analisi e apportato eventuali modifiche, è possibile inserire ulteriori 
informazioni nella finestra Informazioni paziente (Patient Info) e generare e stampare un report.

Porta spO2

Porta pressione
Porta torace

Centro di raccolta 
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Batterie BRAEBON

Per ricaricare le batterie ricaricabili, utilizzare il caricabatterie per batterie al litio 1�2 AA in 
dotazione (Modello 0422). Caricare solo batterie ricaricabili; le batterie Saft non possono 
essere ricaricate. Le batterie non ricaricabili provocano il surriscaldamento del caricabatterie e 
possono provocare incendi o esplosioni.

Il caricabatterie ha una sequenza di LED come indicato nella tabella riportata qui di seguito.

Tabella 1-1: Sequenza di LED del caricabatterie

LED Significato

Rosso, sempre acceso La batteria è in carica

La batteria è completamente caricaBlu, sempre accesoacceso 

Blu lampeggiante, 
rosso lampeggiante

Blu lampeggiante, 
rosso lampeggiante

La polarità delle batterie non è corretta; per continuare, invertire 
la direzione delle batterie.

Se la polarità della batteria è corretta, indica una tensione 
inferiore a 2,7V. Lasciare le batterie nel caricabatterie, quando la 
tensione supera i 2,7 V, il LED diventa rosso per indicare la carica.

MediByte�MediByte Jr utilizza una batteria da 3,6 V 1�2AA, Saft LS14250 (Modello 0410-3) o 
una batteria ricaricabile agli ioni di litio 1�2 AA (Modello 0412) fornita da BRAEBON. La batteria 
non ricaricabile Saft può essere utilizzata per uno studio di due notti, mentre la batteria 
ricaricabile agli ioni di litio 1�2 AA è adatta per uno studio di una notte.
  1-21





Capitolo 2: Specifiche

In questo capitolo
Questo capitolo contiene una serie di tabelle che descrivono MediByte e MediByte Jr. Sono 
inoltre incluse le dichiarazioni del produttore che mostrano la conformità dell'unità alla 
norma IEC 60601-1. Il capitolo comprende:

• Requisiti di sistema

• Classificazione di MediByte e MediByte Jr

• Specifiche di MediByte e MediByte Jr

• Specifiche del pulsossimetro

• Display e indicatori

• Controlli

• Dichiarazioni del produttore
  2-1
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Specifiche tecniche
Requisiti di sistema
MediByte Software funziona su un computer Windows.

Processore del computer

Inteli5, i7 o versioni 

successive o

AMD: Zen Core Architecture, Ryzen 5 (o versioni successive)

Disco rigido 1�2 TB o superiore con un minimo di 5 GB di spazio disponibile.

RAM minima 8GB

Porta USB 2.0 (o versioni successive)

Sistema operativo Windows 10 (o versioni successive)

Software Word 2016 (o versioni successive)
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Classificazione e specifiche di MediByte e MediByte Jr
Tabella 2-1: Registratore MediByte e MediByte Jr Classificazione secondo IEC 60601-1

Alimentato internamente

Tipo BF

Protezione ingresso: IP22; secondo la definizione della norma IEC 60529 è protetto dal contatto con le dita e con 
oggetti di dimensioni superiori a 12,5 mm di diametro e i liquidi da spruzzi inferiori a 15 gradi dalla verticale.

Non è necessaria la sterilizzazione, consultare i metodi di pulizia

Categoria non a prova di anestetico, non adatto a tale applicazione

Funzionamento continuo

Tabella 2-2: Specifiche di MediByte e MediByte Jr

Dimensioni

Peso 3,3 once. con batteria (93 g) MediByte
3,2 once con batteria (91 g) MediByte Jr

2,5” x 2,25” x 0,75” (66 mm x 60 mm x 19 mm)

Plastica (ABS)

1�2 AA 3,6 V Saft LS 14250; potenza massima 25 mA @ 3,6 VDC

Alloggiamento

Alimentazione

Memoria Può memorizzare fino a 18 ore di dati (con audio) o 24 ore (solo con EMG-MediByte)

MediByte e MediByte Jr non contengono sistemi di allarme.
  2-3
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Specifiche tecniche
Tabella 2-3: Specifiche del pulsossimetro

Intervallo di saturazione dell'ossigeno Da 0 a 100%

Intervallo di frequenza del polso Da 18 a 300 pulsazioni al minuto

Precisione
SpO2 (70-100%) (± 1 SD)

Nessun movimento - Adulti, Pediatrico ± 2 cifre; Neonati ± 3 cifre 
Movimento - Adulti, Pediatrico ± 2 cifre; Neonati ± 3 cifre
Bassa perfusione - Adulti, Pediatrico ± 2 cifre; Neonati ± 3 cifre

Precisione della 
frequenza cardiaca

L'OSSIMETRO A IMPULSI è calibrato per visualizzare la SATURAZIONE FUNZIONALE DELL'OSSIGENO.

Il dispositivo e gli accessori sono stati testati secondo la norma EN ISO 80601-2-61:2019.

a) Le sonde SpO2 sono state progettate per l'utilizzo con monitor specifici;
b) l'OPERATORE è responsabile della verifica della compatibilità del monitor, della sonda e del cavo prima 
dell'uso; e
c) i componenti incompatibili possono peggiorare le prestazioni.

Nota: Solo le sonde SpO2 fornite da BRAEBON sono compatibili con MediByte e MediByte Jr.

Lunghezze d'onda di misurazione 
con sensori Nonin

Rosso: 660 nanometri @ 3mW nominali 
infrarossi: 910 nanometri @ 3mW nominali

Nessun movimento (18 - 300 BPM) - Adulti, Pediatrico, Neonati ±3 cifre 
Movimento (40 - 240 BPM) - Adulti, Pediatrico, Neonati ±5 cifre
Bassa perfusione (40 - 240 BPM) - Adulti, Pediatrico, Neonati ±3 cifre
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Display e indicatori
Tabella 2-4: Display e indicatori

Stato DEL

All'inserimento della batteria, verde�rosso alternato per 
quattro secondi

Batteria non inserita, batteria scarica

Funzionamento dell'unità

Non lampeggiante

Verde lampeggiante una volta ogni sei secondi Il registratore è in attesa di raccogliere i dati

Il registratore sta raccogliendo i datiVerde lampeggiante due volte ogni sei secondi

Batteria scaricaRosso lampeggiante una volta ogni sei secondi

 Nessun segnale SpO2�PulsazioniRosso lampeggiante due volte ogni sei secondi

La batteria è troppo scarica per uno studio; 
non registra i dati, ma può ancora funzionare 
per il download dei dati

Rosso intermittente continuo

Verde fisso fino a un minuto al massimo, poi luce verde due 
volte ogni sei secondi

MediByte�MediByte Jr si accende con 
l'interruttore ON�OFF

Tabella 2-5: Controlli

Controllo Funzione

Pulsante Evento Quando viene premuto, il pulsante evento registra la pressione del pulsante. 
L'evento è predefinito dal medico. (solo MediByte)

Interruttore di 
accensione�spegnimen
to della raccolta dati

MediByte�MediByte JR inizierà a raccogliere i dati quando l'interruttore viene 
spostato a destra (punto bianco). L'interruttore viene disattivato in modalità 
automatica.
  2-5
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Specifiche tecniche
Dichiarazione del produttore
Tabella 2-6: Dichiarazioni IEC 60601-1-2

Clausola 6.8.2.201 a) 1) Per le apparecchiature elettromedicali è necessario osservare precauzioni speciali 
in materia di EMC e devono essere installate e attivate in base alle informazioni 
EMC fornite in questo manuale.

Clausola 6.8.2.201 a) 2) Le apparecchiature di comunicazione RF portatili e mobili possono influire sulle 
apparecchiature elettromedicali.

6.8.3.201 a) 1) L'uso di accessori, trasduttori e cavi diversi da quelli specificati dal produttore può 
provocare un aumento delle Emissioni o una riduzione dell'Immunità del Sistema.

6.8.3.201 a) 4) Il Sistema non deve essere utilizzato in prossimità o impilato con altre 
apparecchiature e, se è necessario l'utilizzo in prossimità o impilato, il sistema deve 
essere osservato per verificare il normale funzionamento nella configurazione in cui 
verrà utilizzato.

Tabella 2-7: Guida e dichiarazione del produttore - Emissioni elettromagnetiche

MediByte è destinato all'uso nell'ambiente elettromagnetico specificato qui di seguito. Il cliente o l'utente di 
MediByte deve accertarsi che venga utilizzato in un ambiente di questo tipo.

Test sulle emissioni

Emissioni RF 
CISPR 11

Gruppo 1

Conformità

MediByte utilizza l'energia RF solo per il suo funzionamento 
interno. Le sue emissioni di radiofrequenze sono quindi 
molto basse e non possono causare interferenze nelle 
apparecchiature elettroniche vicine.

Ambiente elettromagnetico - Guida

 

Emissioni RF 
CISPR 11

Classe B MediByte è adatto all'uso in tutte le strutture, comprese 
quelle domestiche e quelle direttamente collegate alla 
rete pubblica di alimentazione a bassa tensione che 
alimenta gli edifici utilizzata per scopi domestici.

 

Emissioni armoniche 
IEC 61000-3-2

Classe B

Fluttuazioni di 
tensione�emissioni di sfarfallio
IEC 61000-3-3

Conforme



Specifiche tecniche
Tabella 2-8: Guida e dichiarazione del produttore - Emissioni elettromagnetiche

MediByte è destinato all'uso nell'ambiente elettromagnetico specificato qui di seguito. Il cliente o l'utente di MediByte deve 
accertarsi che venga utilizzato in un ambiente di questo tipo.

Test di immunità Livello di conformità Guida all'ambiente elettromagnetico

Scarica elettrostatica 
(ESD) IEC 61000-4-2

Contatto ±6 kV

Livello di test IEC 60601

±8 kV aria

Contatto ±6 kV
±8 kV aria

I pavimenti devono essere in legno, cemento 
o in piastrelle di ceramica. Se i pavimenti 
sono rivestiti di materiale sintetico, l'umidità 
relativa deve essere almeno del 30%.

Transitorio elettrico 
veloce�burst IEC 
61000-4-4

±2 kV common mode

<5% UT
(>95% calo in UT)
per 0,5 cicli

40% UT

(60% calo in UT)
per 5 cicli

70% UT
(30% calo in UT)
per 25 cicli

<5% UT
(>95% calo in UT)
per 5 sec.

3 A�m 3 A�m

Non applicabile. 
Alimentazione a 
batteria.

La qualità dell'alimentazione di rete deve 
essere quella di un tipico ambiente 
commerciale o ospedaliero. Se l'utente 
necessita del funzionamento continuo di 
MediByte durante le interruzioni della rete 
elettrica, si consiglia di alimentare MediByte 
tramite un gruppo di continuità o una 
batteria.

I campi magnetici della frequenza di 
alimentazione devono essere ai livelli 
caratteristici di una tipica posizione di un
in un tipico ambiente commerciale o 
ospedaliero

NOTA U T è la tensione di rete a corrente alternata prima dell'applicazione del livello di prova.

±2 kV per le linee 
di alimentazione

Non applicabile. 
Alimentazione 
a batteria.

La qualità dell'alimentazione di rete deve 
essere quella di un tipico ambiente 
commerciale o ospedaliero.

±1 kV per ingresso�uscita
linee

Picco
IEC 61000-4-5

±1 kV modalità 
differenziale

Non applicabile. 
Alimentazione 
a batteria.

La qualità dell'alimentazione di rete deve 
essere quella di un tipico ambiente 
commerciale o ospedaliero.

Cadute di 
tensione, brevi 
interruzioni e 
variazioni di 
tensione sulle linee 
di ingresso 
dell’alimentazione
IEC 61000-4-11

Frequenza di 
alimentazione
(50�60 Hz)
campo magnetico IEC
61000-4-8
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Specifiche tecniche
Tabella 2-9: Guida e dichiarazione del produttore - Immunità elettromagnetica - Per apparecchiature 
e sistemi non di sostegno vitale

MediByte è destinato all'uso nell'ambiente elettromagnetico specificato qui di seguito. Il cliente o l'utente di 
MediByte deve accertarsi che venga utilizzato in un ambiente di questo tipo.

Test di immunità Livello di conformità

RF IEC 61000-4-6 
condotte

3 Vrms

Livello di test IEC 60601

Da 150 kHz a 80 MHz
3 V Le apparecchiature di comunicazione 

RF portatili e mobili non devono essere 
utilizzate più vicino a qualsiasi parte di 
MediByte, compresi i cavi, rispetto alla 
distanza di separazione consigliata 
calcolata dall'equazione applicabile alla 
frequenza del trasmettitore

Guida all'ambiente elettromagnetico

Radiated RF

IEC 61000-4-3

3 V�m
Da 80 MHz a 2,5 GHz

3V�m

dove P è la potenza nominale massima 
di uscita del trasmettitore in watt (W) 
secondo il produttore del trasmettitore 
e d è la distanza di separazione 
consigliata in metri (m). Le intensità di 
campo dei trasmettitori RF fissi, come 
determinate da una verifica 
elettromagnetica in situ, a devono 
essere inferiori al livello di conformità 
in ogni gamma di frequenza.b

Si possono verificare interferenze in 
prossimità di apparecchiature 
contrassegnate dal simbolo indicato qui 
di seguito:



Specifiche tecniche
a

b Nell'intervallo di frequenza compreso tra 150 kHz e 80 MHz, le intensità di campo devono essere inferiori a [3] V�m.

Distanze di separazione consigliate tra apparecchiature di comunicazione RF portatili e mobili e MediByte

MediByte è destinato all'uso in un ambiente elettromagnetico in cui sono controllati i disturbi RF irradiati. Il 
cliente o l'utente di MediByte può contribuire a prevenire l' interferenza elettromagnetica mantenendo una 
distanza minima tra le apparecchiature di comunicazione RF portatili e mobili (trasmettitori) e MediByte, come 
consigliato qui di seguito, in base alla potenza massima di uscita dell'apparecchiatura di comunicazione.

Potenza di uscita massima 
nominale del trasmettitore

(W)

Distanza di separazione in base alla frequenza del trasmettitore m

32.021.021.010.0

37.083.083.01.0

3.22.12.11

3.78.38.301

322121001

Per i trasmettitori con una potenza di uscita massima non elencata sopra, la distanza di separazione raccomandata d 
in metri (m) può essere calcolata usando l'equazione applicabile alla frequenza del trasmettitore, dove P è la 
potenza di uscita massima del trasmettitore in watt (W) secondo il produttore del trasmettitore.
NOTA 1: A 80 MHz e 800 MHz, si applica la distanza di separazione per la gamma di frequenza superiore.
NOTA 2: Queste linee guida potrebbero non essere applicabili in tutte le situazioni. La propagazione 
elettromagnetica è influenzata dall'assorbimento e dalla riflessione di strutture, oggetti e persone.

Tabella 2-9: Guida e dichiarazione del produttore - Immunità elettromagnetica - Per apparecchiature 
e sistemi non di sostegno vitale

NOTA 1: A 80 MHz e 800 MHz si applica la gamma di frequenza superiore.
NOTA 2: Queste linee guida potrebbero non essere applicabili in tutte le situazioni. La propagazione 
elettromagnetica è influenzata dall'assorbimento e dalla riflessione di strutture, oggetti e persone.

   Le intensità di campo dei trasmettitori fissi, come stazioni base per radio (cellulari�cordless), radio mobili, radio 
amatoriali, trasmissioni radiofoniche in AM e FM e trasmissioni televisive non si possono prevedere con precisione. 
Per valutare l'ambiente elettromagnetico dovuto ai trasmettitori RF fissi, è necessario prendere in valutare una 
verifica. Se l'intensità di campo misurata nel luogo in cui viene utilizzato MediByte supera il livello di conformità RF 
applicabile indicato sopra, MediByte dovrebbe funzionare normalmente. Se si osservano prestazioni anomale, 
potrebbero essere necessarie ulteriori misure, come il riorientamento o la ricollocazione di MediByte.
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Specifiche tecniche
Tabella 2-10: Sonde per pulsossimetri convalidate e testate per la conformità alla norma EN 
ISO 80601-2-61

8896 Cavo SpO2 per MediByte

CavoSpO2 per MediByte, Involucro morbido grande

Cavo SpO2 per MediByte, lobo

Cavo SpO2 per MediByte, punta morbida

8898

8899

8900



Capitolo 3: Installazione del software

In questo capitolo
In questo capitolo viene descritto come installare il software MediByte sul computer. Dopo 
aver installato il software, è possibile configurare MediByte�MediByte Jr e iniziare la raccolta 
dei dati. Non è possibile raccogliere i dati prima di aver installato il software e configurato il 
registratore. Quando si configura il registratore, a quest'ultimo vengono comunicati il nome 
del paziente e i parametri dello studio.

Questo capitolo comprende:

• Installazione del software MediByte

• Collegamento di MediByte�MediByte Jr al computer

• Attivazione del software MediByte
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Installazione del software
Installazione di MediByte Software
Il software MediByte viene installato dal sito Braebon.com. Dopo aver installato il software, 

sul desktop verrà visualizzata un'icona MediByte             .

Per installare il software:

L'installazione del software è facile, la procedura guidata guiderà nel processo. 

1. Nel browser web (ad es. Internet Explorer, Firefox), digitare braebon.com/setup.

2. Fare clic su MediByte.

• Fare clic sul link rosso Download di fianco a 
MediByte Software. Il sistema è stato 
progettato per avviare il processo di 
installazione, ma il browser web potrebbe non 
consentirlo. Potrebbe aprirsi una nuova finestra 
che chiede se si desidera salvare il file; fare clic 
su Salva file (Save file). Il software verrà quindi 
scaricato sul computer, di solito nella cartella 
Download.

3. Fare doppio clic sul file di installazione 
MediByte (MediByte Installer File).

4. Potrebbe aprirsi una finestra di sicurezza che 
chiede se si vuole eseguire il file. Fare clic su 
Esegui (Run). Si aprirà l'installazione guidata di 
MediByte.

5. Fare clic su Avanti (Next) per aprire il 
Contratto di licenza software.

6. Esaminare il contratto di licenza software e, se 
si accettano i termini, fare clic sul pulsante di 
selezione di fianco a Accetto i termini del 
contratto di licenza e fare clic su Avanti.

7. Fare clic su Installa (Install).

8. Fare clic su Fine (Finish) per uscire dalla procedura di installazione guidata.
Il so�ware si installa automa�camente in C:\Program Files (x86)\MediByte v9.0 . L'icona di 
MediByte         si trova sul desktop.

Figura 3.1: Download di MediByte Software

Figure 3.2: Installation Wizard



Installazione del software
Collegamento di MediByte al computer

Installare il software prima di collegare MediByte al computer.

1. Inserire una batteria in MediByte.

2. Con il cavo USB MediByte, collegare il connettore grande alla porta USB del computer e il 
connettore piccolo alla porta di comunicazione MediByte. La prima volta che si collega 
MediByte al computer, i driver hardware MediByte si installeranno automaticamente.

3. Fare doppio clic sull'icona del software MediByte         per avviare il MediByte Software.
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6. Digitare il numero di serie presente sul retro di MediByte�MediByte Jr nel campo # di serie 
(Serial#) presente nella pagina di attivazione. Il numero di serie si trova anche sull'etichetta 
della confezione.

7. Fare clic su Attiva MediByte (Activate MediByte). Sarà inviato un Codice di autorizzazione; 
digitarlo nel campo Inserisci codice di autorizzazione (Enter Authorization Code) nella 
schermata Attivazione software   e fare clic su Autorizza (Authorize).

8. Una finestra pop-up informerà sull'esito dell'operazione. Ora è possibile utilizzare MediByte.
Attivazione di MediByte Software

116893
73673

Figura 3.3: Attivazione on-line di MediByte Software

253939

1. Fare doppio clic sull'icona del software MediByte         sul desktop. Questa azione apre la 
pagina Attivazione Software.

2. Selezionare la lingua che si vuole usare dal menu a discesa. Selezionare la lingua prima di 
attivare MediByte. È possibile anche cambiare la lingua nella schermata Analisi in MediByte 
Software.

3. Prendere nota del Codice di attivazione visualizzato sullo schermo.

4. Selezionare il pulsante Fai clic qui (Click Here) per aprire la pagina di attivazione on-line di 
BRAEBON.

La prima volta che si utilizza MediByte Software, è necessario autorizzarlo. L'autorizzazione del 
software prevede l'inserimento del numero di serie di MediByte e un codice di attivazione nella 
pagina di attivazione on-line di BRAEBON. La pagina genererà un codice di autorizzazione da 
digitare nella pagina di Attivazione Software (Software Activation). Se non si ha accesso a 
Internet, chiamare il numero 1.888.462.4841 (9-17 EST).
5. Digitare il Codice di attivazione (Activation Code) nel campo Codice di attivazione nella 
pagina di attivazione on-line.



5. Digitare il Codice di attivazione (Activation Code) nel campo Codice di attivazione nella 
pagina di attivazione on-line.

1. Fare doppio clic sull'icona del software MediByte         sul desktop. Questa azione apre la 
pagina Attivazione Software.

2. Selezionare la lingua che si vuole usare dal menu a discesa. Selezionare la lingua prima di 
attivare MediByte. È possibile anche cambiare la lingua nella schermata Analisi in MediByte 
Software.

3. Prendere nota del Codice di attivazione visualizzato sullo schermo.

4. Selezionare il pulsante Fai clic qui (Click Here) per aprire la pagina di attivazione on-line di 
BRAEBON.

Installazione del software
6. Digitare il numero di serie presente sul retro di MediByte�MediByte Jr nel campo # di serie 
(Serial#) presente nella pagina di attivazione. Il numero di serie si trova anche sull'etichetta 
della confezione.

7. Fare clic su Attiva MediByte (Activate MediByte). Sarà inviato un Codice di autorizzazione; 
digitarlo nel campo Inserisci codice di autorizzazione (Enter Authorization Code) nella 
schermata Attivazione software   e fare clic su Autorizza (Authorize).

8. Una finestra pop-up informerà sull'esito dell'operazione. Ora è possibile utilizzare MediByte.

522522
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Capitolo 4: Preparazione di MediByte

In questo capitolo
In questo capitolo viene descritto come preparare MediByte e MediByte Jr per uno studio. 
Per preparare un registratore, è necessario collegarlo al computer e utilizzare la procedura 
guidata MediByte per programmarlo.

Questo capitolo contiene informazioni relative a come:

1. inserire una nuova batteria in MediByte�MediByte Jr;

2. collegare MediByte�MediByte Jr al computer e avviare il software;

3. selezionare un'operazione;

4. inserire le informazioni sul paziente;

5. selezionare un dispositivo ausiliario (solo MediByte);

6. selezionare l'ora di inizio;

7. esaminare le impostazioni e configurare MediByte�MediByte Jr;

8. preparare un kit per il paziente.
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Preparazione di MediByte
Preparazione di MediByte per uno studio

La preparazione di MediByte/MediByte Jr per uno studio comprende le fasi riportate qui di seguito:

1.  Inserire una batteria nuova in MediByte�MediByte Jr.
La batteria Saft LS14250, Modello 0410-3, dura per due studi notturni. Per essere sicuri di 
non perdere l'alimentazione durante uno studio, inserire una nuova batteria prima di 
configurare MediByte�MediByte Jr. Se si utilizzano batterie ricaricabili, non è possibile 
eseguire uno studio di due notti senza cambiare le batterie tra uno studio e l'altro.

Prima di iniziare
1. Installare il software MediByte (vedere Capitolo 3).

2. Inserire una nuova batteria in MediByte�MediByte Jr.

3. Accertarsi che il paziente non sia collegato a MediByte�MediByte Jr.

1. inserimento di una nuova batteria in MediByte�MediByte Jr.

2. Con il cavo USB, collegare MediByte�MediByte Jr al computer e fare clic sull'icona 
MediByte Software per avviare MediByte Software.

3. Selezionare un'operazione nella procedura guidata MediByte.

4. Inserire il nome, l'ID e il peso del paziente.

5. Selezionare un dispositivo ausiliario (solo MediByte).

6. Selezionare l'ora di inizio.

7. Esaminare le impostazioni e configurare MediByte�MediByte Jr.

1. Utilizzando il cacciavite esagonale fornito con il kit, rimuovere la vite del vano batteria.

2. Rimuovere il coperchio del vano batteria spingendolo verso il basso e lontano 
dall'utente. Utilizzare il nastro per estrarre la batteria usata.

3. Con il nastro sul fondo del vano batteria, inserire una nuova batteria accertandosi che la 
polarità della batteria corrisponda al diagramma sul fondo del vano.

4. Riposizionare il coperchio del vano batteria, reinserire la vite e stringerla. Non stringere 
eccessivamente la vite per evitare di spanarla.



Preparazione di MediByte

2. Nella finestra Selezione operazione (Operation 
Selection), selezionare dall'elenco delle attività.
2.  Collegamento di MediByte�MediByte Jr al computer

Per collegare MediByte/MediByte Jr al computer:

2. Fare doppio clic sull'icona del software MediByte         sul desktop per avviare il software. 
Il software rileverà automaticamente se il registratore è MediByte o MediByte Jr.

3.  Selezionare un'operazione nella procedura guidata

NON collegare MediByte/MediByte Jr al computer mentre è a contatto 
con il paziente. Questo potrebbe causare gravi lesioni al paziente.

Figura 4.1: Schermata di apertura

1. collegare l'estremità grande del cavo USB alla porta USB del computer e collegare l'altra 
estremità del cavo USB a MediByte�MediByte Jr.

Il software è dotato di procedura guidata MediByte che guida l'utente nelle impostazioni del 
sistema. Qui è possibile scegliere se configurare MediByte�MediByte Jr per uno studio, 
scaricare i dati o rivedere un file di dati esistente.

1. La procedura guidata MediByte chiede di 
confermare che il paziente non è collegato a 
MediByte�MediByte Jr facendo clic sulla casella 
di spunta.

• Fare clic su Avanti per continuare.
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1. La procedura guidata MediByte chiede di 
confermare che il paziente non è collegato a 
MediByte�MediByte Jr facendo clic sulla casella 
di spunta.
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Preparazione di MediByte
2. Nella finestra Selezione operazione (Operation 
Selection), selezionare dall'elenco delle attività.

4.  Inserimento delle informazioni sul paziente

 

Figura 4.2: Finestra Selezione delle operazioni

Figura 4.3: Finestra Informazioni sul paziente

• Per preparare uno studio, selezionare Configura 
Medibyte per uno studio (Configure the Medibyte 
for a Study) e fare clic su Avanti per passare alla 
schermata Paziente.

• Per recuperare i dati dal registratore, selezionare 
Scarica dati da MediByte e fare clic su Avanti per 
avviare il download dei dati.

• Per esaminare un file di dati memorizzato sul 
computer, selezionare Esamina file di dati esistente 
(Review Existing Data File) e fare clic su Avanti per 
aprire la finestra Carica ed esamina (Load and 
Review) e selezionare un file di dati.

• La licenza Rinnova MediByte (Renew MediByte) 
(dispositivo a uso illimitato) non è attiva perché il 
dispositivo ha un numero illimitato di utilizzi.

Nella finestra Informazioni sul paziente, inserire il nome, il numero di identificazione e il peso del 
paziente. Inserire correttamente queste informazioni, poiché il nome del file del paziente viene 
creato utilizzando il cognome e l'ID del paziente.

1. Digitare il cognome del paziente nel campo 
Cognome (Last Name). Questo campo ha un 
numero limitato di 20 caratteri.

2. Digitare il nome del paziente nel campo Nome 
(Name). Questo campo ha un numero limitato di 
12 caratteri.

3. Digitare il codice univoco del paziente nel campo 
ID paziente (Patient ID). Questo campo ha un 
numero limitato di dieci caratteri.

4. Digitare il peso del paziente in chilogrammi o in 
libbre. Il peso inserito determina se si tratta di 
un paziente adulto o pediatrico; ad esempio, un 
peso superiore a 25 kg (55 libbre) è considerato 
adulto. Il peso predefinito è di 45 kg (100 libbre).

5. Fare clic su Avanti per passare alla schermata 

successiva. Non è possibile utilizzare il pulsante 
Avanti fino a quando non sono state inserite le 
informazioni in tutti i campi.



Preparazione di MediByte
5.  Selezionare un dispositivo ausiliario (solo MediByte)

Opzioni aggiuntive:

Mentre viene selezionata ogni voce, l'immagine corrispondente alla selezione cambia.

Figure 4.4: Auxiliary device window

La procedura guidata MediByte chiede di selezionare la funzione della porta ausiliaria. 
Utilizzare questa schermata per selezionare l'accessorio esterno che si desidera utilizzare 
per la registrazione; è l'accessorio che si collega alla porta AUX.

Se si seleziona Non usare AUX, non selezionare Usa termistore flusso 
d'aria (Use Airflow Thermistor).

1. Selezionare il dispositivo ausiliario dall'elenco e 
fare clic su Avanti  per passare alla schermata 
dell'ora di inizio.

• Microfono per il russamento

• ECG

• EMG Bruxismo

• EMG PLM

• Sonno

• Sonno + ECG*

• Sonno + EEG*

• Non utilizzare il canale AUX

• Utilizzare il termistore flusso d'aria

• Utilizzare la pressione CPAP

* Questi montaggi richiedono la Scatola elettrodi 8612 SE. Non è possibile utilizzare il 
termistore con questi montaggi.
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6.  Selezionare l'Ora di inizio

Per la riuscita di una registrazione di due notti, selezionare la modalità automatica. 
Questa modalità preserva l'energia della batteria.

Figura 4.5: Selezione dell'ora di avvio

Selezionare se la registrazione verrà avviata automaticamente o manualmente. Automaticamente 
significa che MediByte�MediByte Jr inizierà a registrare i dati all'ora specificata; l'interruttore di 
attivazione�disattivazione della raccolta è disattivato. Manualmente significa che l'interruttore di 
attivazione�disattivazione della raccolta è abilitato e che il paziente deve avviare la registrazione 
dei dati premendo l'interruttore di attivazione�disattivazione della raccolta su MediByte� 
MediByte Jr verso destra (punto bianco).

1. Selezionare l'avvio automatico o manuale. Se si 
seleziona l'avvio automatico, è necessario 
selezionare la data e l'ora di avvio.

2. Selezionare uno studio di una o due notti e fare 
clic su Avanti per andare alla schermata di 
riepilogo. Se si è scelto di eseguire uno studio 
ECG, si potrà anche selezionare uno studio di 
24 ore.
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7.  Esaminare le impostazioni e configurare MediByte
La schermata di riepilogo consente di rivedere le impostazioni prima di configurare 
MediByte�MediByte Jr. Se le impostazioni sono corrette, avviare la configurazione facendo 
clic su Avanti. Se è necessario modificare una delle impostazioni, utilizzare il pulsante 
Indietro (Back) per tornare alle schermate precedenti.

2. Selezionare Fine. Il software invia le 
informazioni sul paziente e le impostazioni 
dello studio al registratore. Questa azione si 
chiama configurazione di MediByte� MediByte 
Jr. Una volta configurato il registratore, il 
software si chiude automaticamente e si può 
scollegare il registratore dal computer.

Ora MediByte�MediByte Jr è pronto per 
registrare uno studio.

Quando si configura MediByte�MediByte Jr, il software invia le informazioni sul 
paziente e le impostazioni dello studio al registratore. È necessario configurare il 
registratore prima di avviare uno studio.

Figura 4.6: Schermata di riepilogo

Figura 4.7: Schermata finale

1. Esaminare la schermata di riepilogo. Se le 
impostazioni sono corrette, fare clic su Avanti. 
Il software confermerà di aver terminato e di 
essere pronto a configurare il registratore.
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8.  Preparazione di un kit MediByte per il paziente
Il kit MediByte Jr contiene tutti gli articoli necessari per uno studio. Per MediByte, preparare il 
kit con i soli sensori necessari al paziente per eseguire lo studio.

Tipo di studio Requisiti

Nessun Aux (Studio con 
cannula)

Russamento

ECG

MediByte
2 Bande RIP con cavi 
SpO2 Cavo
Scatola elettrodi
3 Kit di preparazione delle 
terminazioni cavi per ECG (24")

BRUX o SONNO

MediByte
2 bande RIP con cavi S
pO2 Cavo
Scatola elettrodi
Kit preparazione elettrodi 
4 terminazioni cavi ECG (24”)

PLM

MediByte
2 bande RIP con cavi 
SpO2 Cavo
Scatola elettrodi
4 terminazioni cavi  (60”)
Kit preparazione elettrodi 1 
terminazione cavi ECG (24”)

SONNO + ECG o 
SONNO +EEG

MediByte
2 bande RIP con cavi 
SpO2 Cavo
Kit paziente

MediByte
2 bande RIP con cavi 
SpO2 Cavo
Kit paziente con microfono 
per il russamento

MediByte
2 bande RIP con cavi 
SpO2 Cavo
Scatola elettrodi SE
Kit preparazione elettrodi 5 
terminazioni cavi ECG (24”)



Capitolo 5: Preparazione del paziente

In this chapter
Questo capitolo descrive come posizionare i sensori sul paziente, dove collegare i sensori a 
MediByte�MediByte Jr, come avviare e come terminare uno studio.

Questo capitolo comprende:

• Studio MediByte Jr

• Studio della pressione CPAP (MediByte Jr)

• Studio del russamento (MediByte)

• Posizionamento degli elettrodi del canale ausiliario (MediByte)

• Avvio dello studio

• Conclusione dello studio

• Banda RIP per MediByte

• Cavo SpO2 per MediByte

• Cannula

• Bande RIP toraciche e addominali
• Microfono per il russamento
• Posizionamento della cannula o
• Cannula con posizionamento del termistore
• Cavo SpO2 per MediByte

• Studio ECG
• Studio EMG Bruxismo
• Studio EMG PLM
• Studio del sonno
• Studio del sonno + studio ECG
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yte.

.

Studio MediByte Jr
Lo studio MediByte Jr utilizza una cannula, una banda RIP per MediByte e un cavo SpO2 per MediB

La preparazione di uno studio MediByte Jr è molto facile e il paziente può di solito eseguirla a casa

Figura 5.1: Studio MediByte Jr



Preparazione del paziente
1. Posizionare la banda RIP toracica
La banda RIP toracica si aggancia a MediByte Jr, come illustrato.

Figura 5.2: Posizionamento della banda RIP toracica

1. Con MediByte Jr in posizione verticale e 
rivolto verso l'utente, agganciare la banda 
nera alla clip destra di MediByte Jr.

2. Stringere la banda il più possibile; è molto 
più facile allentare una banda stretta sul 
corpo che stringere una banda allentata.

3. Avvolgere la banda intorno al torace e 
agganciarla alla clip MediByte Jr rimanente.

4. Accertarsi che la banda sia posizionata sopra o sotto 
la linea del capezzolo del paziente e si allenti per ottenere una vestibilità fissa ma confortevole.

5. Prendere il cavo nero a forma di Y e collegare un connettore della spina di sicurezza alla presa 
sinistra situata sulla banda e l'altro connettore della spina di sicurezza alla presa destra.

6. Se si desidera, utilizzare il nastro adesivo medico per fissare i fili.

7. Inserire il connettore nell'incavo nero in basso a destra di MediByte Jr. (quando si indossa), 
contrassegnato con TORACE (CHEST).
  5-3



5-4

Preparazione del paziente
Figura 5.3: Posizionamento della cannula della pressione

Figura 5.4: Collegare il filtro della pressione all'attacco 
della cannula della pressione.

Posizionamento della cannula (MediByte Jr):
1. Posizionare i rebbi nasali nelle narici del paziente 

e avvolgere i tubi sopra le orecchie e sotto il 
mento.

2. Con il nastro adesivo medico, fissare i tubi al viso 
del paziente.

3. Regolare il cursore per ottenere una vestibilità 
confortevole sotto il mento.

4. Su MediByte Jr, avvitare il filtro all'estremità della 
cannula all'ingresso contrassegnato con 
PRESSIONE (PRESSURE). NON stringere 
eccessivamente il filtro.



Preparazione del paziente
Posizionare il cavo SpO2 per MediByte (MediByte Jr)

Rimuovere le unghie artificiali e lo smalto dal dito scelto prima di cominciare.

Figura 5.5: Utilizzo del cavo SpO2 per MediByte

Accertarsi che il punto rosso sul connettore della sonda del dito sia allineato con il 
punto rosso su MediByte Jr. NON torcere il connettore; si muoverà facilmente 
dentro e fuori dalla porta dopo l'allineamento dei punti. Dare un leggero strattone 
al connettore per accertarsi che sia completamente collegato e che non si allenti 
durante la notte.

Figura 5.6: Collegamento del sensore alla porta SpO2

Il tempo massimo di applicazione 
per un sito (dito) è di nove ore.

1. Inserire il dito medio pulito (consigliato) nel 
proteggi dita in silicone. Allineare il sensore a 
emissione luminosa sul letto ungueale. La punta 
del dito non deve attraversare l'estremità del 
proteggi dita.

2. Fissare il cavo del sensore con nastro adesivo 
medico dopo la seconda nocca; accertarsi che il 
dito possa piegarsi liberamente e che il 
movimento non sia limitato.

3. Su MediByte Jr, far scorrere il connettore del 
sensore nell'ingresso contrassegnato con SpO2, 
accertandosi che il punto rosso sul connettore 
sia allineato con il punto rosso sull'ingresso 
SpO2.

Sensore ad emissione di luce
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Preparazione del paziente
Studio della pressione CPAP (MediByte Jr)

Figura 5.7: Studio CPAP

Per lo studio della pressione CPAP, il paziente 
indossa il casco CPAP collegato a MediByte Jr 
con il tubo della pressione CPAP e il sensore 
SpO2. La pagina successiva illustra come 
collegare MediByte all'adattatore CPAP 
(Modello 8552) al casco CPAP. Per posizionare 
il sensore SpO2 sul paziente, vedere pagina 5-5.

La preparazione per lo studio della pressione 
CPAP è così semplice che di solito il paziente 
può farla a casa.



Preparazione del paziente
Figura 5.8: Collegamento di MediByte all'adattatore 
CPAP (Modello 8552) all'ugello di uscita CPAP

Figura 5.8: Collegamento del tubo della pressione 
CPAP all'attacco della pressione

Figura 5.8: Attacco alternativo

1. Posizionare la maschera CPAP sul paziente. Il diagramma 
illustra una maschera CPAP generica, la maschera del 
paziente potrebbe avere un aspetto diverso.

2. Collegare l'adattatore MediByte per CPAP 
(Modello 8552) all'ugello di uscita CPAP.

3. Su MediByte Jr, avvitare l'estremità del filtro di 
MediByte all'adattatore CPAP (Modello 8552) 
all'ingresso contrassegnato con PRESSIONE 
(PRESSURE). NON stringere eccessivamente il filtro.

Attacco alternativo: collegare il tubo della 
pressione alla porta dell'ugello della maschera 
CPAP (mostrato). In alternativa, è possibile 
collegare MediByte all'adattatore CPAP 
(Modello 8552) a un adattatore in-linea.

Collegamento del tubo della pressione CPAP:
  5-7



5-8

Preparazione del paziente
Studio del russamento (MediByte)

Figura 5.9: Studio del russamento



Preparazione del paziente
Bande RIP toraciche e addominali
Le bande RIP toraciche e addominali registrano lo sforzo respiratorio.

Posizionamento della 
banda RIP toracica
La banda RIP toracica si aggancia a MediByte 
come illustrato.

Figura 5.10: Posizionamento della banda RIP toracica

1. Con MediByte in posizione verticale e 
rivolto verso l'utente, agganciare la 
banda nera alla clip destra di MediByte.

2. Stringere la banda il più possibile; è molto 
più facile allentare una banda stretta sul 
corpo che stringere una banda allentata.

3. Avvolgere la banda intorno al torace e 
agganciarla alla clip MediByte rimanente.

4. Accertarsi che la banda si trovi al di sopra o al di sotto della linea dei capezzoli del paziente e 
allentarla per ottenere una vestibilità fissa ma confortevole.

5. Prendere uno dei cavi neri a forma di Y e collegare un connettore della spina di sicurezza alla 
presa sinistra situata sulla banda (cerchiata) e l'altro connettore della spina di sicurezza alla 
presa destra (cerchiata).

6. Se si desidera, utilizzare il nastro adesivo medico per fissare i fili.

7. Inserire il connettore nell'incavo nero in basso a destra di MediByte, marcato TORACE.
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Preparazione del paziente
Figura 5.11: Posizionamento della banda RIP addominale

Posizionamento della banda 
RIP addominale
La banda RIP addominale è posizionata 
sotto la gabbia toracica.

1. Come per la banda RIP toracica, 
stringere la banda il più possibile prima 
di indossarla.

2. Avvolgere la banda intorno all'addome 
del paziente e chiuderla a scatto. 
Allentare per ottenere una vestibilità 
fissa ma confortevole.

3. Prendere il restante cavo nero a Y e 
collegare un connettore della spina di 
sicurezza alla presa sinistra situata sulla 
banda e l'altro connettore della spina di 
sicurezza alla presa destra.

4. Se si desidera, utilizzare il nastro adesivo 
medico per fissare i fili.

5. Inserire il connettore nell'incavo nero in 
basso a sinistra di MediByte, 
contrassegnato con ADDOME 
(ABDOMEN).



Preparazione del paziente
Microfono per il russamento
Il microfono per il russamento raccoglie i suoni 
durante il russamento.

Figura 5.13: Collegamento del microfono per il russomento 
AUX.

1. Posizionare il microfono per il russamento 
sulla fronte o sulla guancia del paziente.

2. Fissare il microfono per il russamento con 
nastro adesivo medico.

3. Inserire il microfono per il russamento nella 
porta AUX di MediByte, accertandosi che il 
segno rosso sul connettore sia allineato con 
il segno rosso sulla porta (cerchiato).

4. Se si utilizza un termistore per cannula 
cTherm, collegare il connettore del 
termistore per cannula cTherm al 
connettore bianco del microfono per il 
russamento. Vedere pagina 5-13 per il 
posizionamento del termistore per cannula 
cTherm.

Figura 5.12: Posizionamento del microfono per il 
russamento
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Preparazione del paziente
Posizionamento della cannula
La cannula misura il flusso d'aria.

Figura 5.14: Posizionamento della cannula della 
pressione

Figura 5.15: Collegare il filtro della pressione all'attacco 
della cannula della pressione.

1. Posizionare i rebbi nasali nelle narici del 
paziente e avvolgere i tubi sopra le orecchie 
e sotto il mento.

2. Con il nastro adesivo medico, fissare i tubi 
alle guance del paziente.

3. Regolare il cursore per ottenere una 
vestibilità confortevole sotto il mento.

4. Su MediByte avvitare il filtro all'estremità 
della cannula all'ingresso contrassegnato con 
PRESSIONE. NON stringere eccessivamente il 
filtro.



Preparazione del paziente
Cannula con posizionamento del termistore
La cannula e il termistore misurano entrambi il 
flusso d'aria.

Figura 5.16: Cannula di pressione con termistore

Figura 5.17: Collegamento della cannula di pressione 
e del termistore

1. Posizionare il termistore della cannula 
cTherm sulla cannula in modo che il 
termistore della cannula cTherm sia rivolto 
verso il paziente. In altre parole, il termistore 
della cannula cTherm si trova dietro la 
cannula quando viene applicata al paziente.

2. Posizionare i rebbi nasali nelle narici del 
paziente; il boccaglio del termistore della 
cannula cTherm si trova all'interno, più vicino 
alla bocca.

3. Afferrare delicatamente il tubo della cannula 
e i fili del termistore della cannula cTherm e 
avvolgerli sopra le orecchie e sotto il mento.

4. Regolare i cursori sulla cannula e sul 
termistore della cannula cTherm per ottenere 
un adattamento confortevole  sotto il mento.

5. Su MediByte avvitare il filtro all'estremità 
della cannula all'ingresso contrassegnato con 
PRESSIONE. NON stringere eccessivamente il 
filtro.

6. Il termistore della cannula cTherm si inserisce 
nel microfono per il russamento.

Figura 5.18: posizionamento di cTherm sulla cannula
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Preparazione del paziente
Cavo SpO2 per MediByte

Rimuovere le unghie artificiali e lo smalto dal dito scelto prima di cominciare.

Figura 5.19: Utilizzo del cavo SpO2 per MediByte

Accertarsi che il punto rosso sul connettore della sonda per il dito sia allineato 
con il punto rosso su MediByte. NON torcere il connettore; si muoverà 
facilmente all'interno e all'esterno della porta dopo aver allineato i punti. Tirare 
leggermente il connettore per accertarsi che sia completamente collegato e 
non si allenti durante la notte.

Figura 5.20: Collegamento del sensore alla porta SpO2

Il tempo massimo di 
applicazione per un sito 
(dito) è di nove ore.

1. Inserire il dito medio pulito (consigliato) nel 
proteggi dita in silicone. Allineare il sensore a 
emissione luminosa sul letto ungueale. 
La punta del dito NON deve attraversare 
l'estremità del proteggi dita.

2. Fissare il cavo del sensore con nastro medico 
dopo la seconda nocca. Accertarsi che il dito 
possa piegarsi liberamente e che il 
movimento non sia limitato.

3. Su MediByte, far scorrere il connettore del 
sensore nell'ingresso contrassegnato con 
SpO2, accertandosi che il punto rosso sul 
connettore sia allineato con il punto rosso 
sull'ingresso SpO2.



Preparazione del paziente
Utilizzo di un cavo FlexiWrap SpO2 per MediByte

1. Con FlexiWrap rivolto verso il basso sul tavolo, tirare la linguetta 
e staccare il supporto di carta. FlexiWrap ha alcune aperture che 
si adattano al sensore per le dita.

• Inserire il sensore nelle aperture di FlexiWrap.

2. Posizionare il dito indice sul sensore in modo che la linea tratteggiata 
su FlexiWrap sia in corrispondenza della punta del dito.

• Avvolgere i piccoli lembi laterali intorno al lato del dito.

3. Piegare FlexiWrap sulla parte superiore del dito indice in modo 
che le parti in rilievo del sensore siano allineate verticalmente.

• Avvolgere i piccoli lembi laterali intorno al lato del dito.

4. Avvolgere il lembo lungo intorno al dito.

5. Utilizzare il nastro adesivo medico per fissare le terminazioni 
sul braccio del paziente. Se il paziente indossa una maglia a 
maniche lunghe, è possibile far passare il cavo lungo la manica 
e fuori dall'apertura del collo, evitando il nastro adesivo.

Non avvolgere FlexiWrap intorno al dito in modo troppo stretto, 
si rischia di limitare il flusso sanguigno.

Figura 5.21: FlexiWrap e sensore

Figura 5.22: Dito sul sensore

Figura 5.23: Piegare e avvolgere

• Intorno alla base del dito indice, fissare il cavo del sensore con 
        nastro adesivo medico.

Figura 5.24: Avvolgere il 
lembo lungo
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Preparazione del paziente
Posizionamento dell'elettrodo ECG
Il gruppo di elettrodi ECG utilizza elettrodi adesivi e a scatto che si inseriscono nella scatola 
elettrodi (modello 8611). La scatola elettrodi è collegata ad AUX su MediByte.

Per utilizzare gli elettrodi adesivi 
e a scatto:

Figura 5.25: Elettrodo adesivo e a scatto

Figura 526: Scatola elettrodi collegata ad AUX

1. inserire le terminazioni cavi, in base al loro 
colore, nella scatola elettrodi

2. raschiare l'area con un panno imbevuto di 
alcol per dieci secondi e lasciare asciugare

3. staccare la parte posteriore dal cuscinetto 
adesivo e applicare il cuscinetto sull'area 
raschiata

4. agganciare l'elettrodo al cuscinetto adesivo.

Elettrodi



Preparazione del paziente
Per utilizzare il gruppo elettrodi ECG:

Figura 5.27: Posizionamento dell'elettrodo ECG

1. posizionare un cuscinetto adesivo sulla 
gabbia toracica sinistra e collegare 
l'elettrodo nero al cuscinetto.

2. posizionare un cuscinetto adesivo sulla 
spalla destra e collegare l'elettrodo rosso al 
cuscinetto

3. posizionare un cuscinetto adesivo sulla 
spalla sinistra (questa è la massa) e collegare 
l'elettrodo verde al cuscinetto

4. inserire le terminazioni cavi in base al loro 
colore nella scatola elettrodi

5. inserire la terminazione della Scatola 
elettrodi nella porta AUX di MediByte 
accertandosi che il punto rosso sia allineato 
con il punto rosso sulla porta.

6. Se si utilizza il termistore della cannula 
cTherm, collegare il connettore del cTherm 
alla porta bianca situata sul fondo della 
scatola elettrodi.
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Preparazione del paziente
Posizionamento dell'elettrodo per il bruxismo

Per utilizzare il gruppo bruxismo

Figura 5.28: Posizionamento del gruppo bruxismo (terminazioni 
non mostrate)

1

2

3 4

Il gruppo elettrodi per il bruxismo utilizza quattro elettrodi adesivi e a scatto che si inseriscono 
nella scatola elettrodi (Modello 8611). La scatola elettrodi si inserisce in AUX su MediByte. Per 
utilizzare gli elettrodi adesivi e a scatto, vedere pagina 5-16.

1. Per localizzare il temporale, chiedere al 
paziente di stringere leggermente la 
mandibola e posizionare un cuscinetto 
adesivo all'apice del rigonfiamento 
muscolare; 1 sul diagramma.
• Collegare un elettrodo nero al cuscinetto.

1. Collegare un cuscinetto adesivo 
dell'elettrodo adesivo all'arco zigomatico 
(zigomo); 2 sul diagramma.
• Collegare un elettrodo rosso 

al cuscinetto.

1. Per localizzare il massetere, chiedere al 
paziente di stringere leggermente la 
mandibola e posizionare un cuscinetto 
adesivo dell'elettrodo all'apice del 
rigonfiamento muscolare; 3 sul diagramma.
• Collegare un elettrodo nero al cuscinetto.

1. Collegare un cuscinetto adesivo 
all'elettrodo al processo mastoideo; 4 sul 
diagramma.
• Collegare l'elettrodo verde a

l cuscinetto. Questa è la massa.

1. Inserire le terminazioni cavi in base al colore 
nella scatola elettrodi.

2. Inserire la terminazione della scatola 
elettrodi nella porta AUX di MediByte, 
accertandosi che il punto rosso del 
connettore sia allineato con il punto rosso 
della porta.



Preparazione del paziente
Posizionamento dell'elettrodo PLM

Per utilizzare il gruppo elettrodi PLM:

Figura 5.29: Posizionamento dei sensori dello studio PLM; 
cavi sotto i pantaloncini

Il gruppo elettrodi PLM utilizza elettrodi adesivi e a scatto che si inseriscono nella scatola 
elettrodi (Modello 8611). La scatola elettrodi si inserisce in AUX su MediByte. Per utilizzare gli 
elettrodi adesivi e a scatto, vedere pagina 5-16.

1. sull'arto anteriore destro, posizionare un 
cuscinetto adesivo e collegare un 
elettrodo rosso al cuscinetto

2. posizionare un secondo cuscinetto 
adesivo 5 cm (2”) sopra il primo e 
collegare un elettrodo nero al cuscinetto

3. ripetere per l'arto sinistro

4. posizionare il cuscinetto adesivo sulla 
spalla sinistra (questa è la massa) e 
collegare l'elettrodo verde al cuscinetto

5. inserire le terminazioni cavi in base al 
loro colore nella scatola elettrodi

6. Inserire la terminazione della scatola 
elettrodi nella porta AUX di MediByte, 
accertandosi che il punto rosso del 
connettore sia allineato con il punto 
rosso della porta

7. fissare le terminazioni cavi allentate con il 
nastro adesivo.
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Preparazione del paziente
Posizionamento degli elettrodi per lo studio del sonno

Per utilizzare il gruppo Studio del sonno:

Figura 5.30: Posizionamento degli elettrodi per lo studio 
del sonno

Il gruppo di elettrodi per lo studio del sonno utilizza quattro elettrodi adesivi e a scatto che si 
inseriscono nella scatola elettrodi (Modello 8611). La scatola elettrodi si inserisce in AUX su 
MediByte. Per utilizzare gli elettrodi adesivi e a scatto, vedere pagina 5-16.

1. posizionare un cuscinetto adesivo dell'elettrodo 
in posizione FPz al centro della fronte
• collegare un elettrodo nero al cuscinetto

1. posizionare un cuscinetto adesivo 
dell'elettrodo  su E1 (occhio sinistro 1 cm di 
canto esterno, 1 cm inferiore)
• collegare un elettrodo rosso al cuscinetto

1. posizionare un cuscinetto adesivo 
dell'elettrodo sul mento
• collegare un elettrodo rosso al cuscinetto

1. collegare un cuscinetto adesivo 
dell'elettrodo su M1, il processo mastoideo
• collegare l'elettrodo verde al cuscinetto. 

Questa è la massa

1. inserire le terminazioni cavi in base al loro 
colore nella scatola elettrodi

2. inserire la terminazione della scatola 
elettrodi nella porta AUX di MediByte, 
accertandosi che il punto rosso del 
connettore sia allineato con il punto rosso 
della porta

Dietro
l'orecchio



Preparazione del paziente
Sonno + ECG

Per utilizzare il gruppo Sonno+ ECG:

Figura 5.31: Posizionamento dell'elettrodo 
sonno + ECG

Il gruppo di elettrodi per lo studio del sonno + ECG utilizza cinque elettrodi adesivi e a scatto 
che si inseriscono nella Scatola elettrodi SE (Modello 8612). La scatola elettrodi si inserisce 
nell'AUX sul MediByte. Per utilizzare gli elettrodi adesivi e a scatto, vedere pagina 5-16.

1. posizionare un cuscinetto adesivo 
dell'elettrodo sulla posizione FPz del centro 
della fronte
• collegare un elettrodo rosso al cuscinetto

1. posizionare un cuscinetto adesivo 
dell'elettrodo  su E1 (occhio sinistro 1 cm di 
canto esterno, 1 cm inferiore)
• collegare un elettrodo nero al cuscinetto

1. posizionare un cuscinetto adesivo 
dell'elettrodo sul mento
• collegare un elettrodo rosso al cuscinetto.

1. posizionare un cuscinetto adesivo su M1, il 
processo mastoideo
• collegare un elettrodo verde (massa) al 

cuscinetto

1. posizionare un cuscinetto adesivo sulla gabbia 
toracica destra o sinistra
• collegare l'elettrodo arancione al cuscinetto

1. inserire le terminazioni cavi in base al colore 
nella Scatola elettrodi SE

2. inserire la terminazione della Scatola elettrodi 
SE nella porta AUX di MediByte, accertandosi 
che il punto rosso del connettore sia allineato 
con il punto rosso della porta.

Dietro 
l’orecchio
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Preparazione del paziente
Sonno + EEG
Il gruppo elettrodi per lo studio del sonno + EEG utilizza cinque elettrodi adesivi e a strappo che 
si inseriscono nella Scatola elettrodi SE opzionale (Modello 8612). La scatola elettrodi SE si 
inserisce nell'AUX sul MediByte. Per utilizzare gli elettrodi adesivi e a scatto, vedere pagina 5-16.

Per utilizzare il gruppo Sonno + EEG:

È possibile utilizzare altre posizioni di elettrodi 10-20 EEG, ma sarà necessario 
l'utilizzo di tecniche di applicazione degli elettrodi diverse.

Figura 5.32: Posizionamento dell'elettrodo 
sonno + EEG

1. posizionare un cuscinetto adesivo dell'elettrodo 
sulla posizione FPz del centro della fronte
• collegare un elettrodo rosso al cuscinetto

1. posizionare un cuscinetto adesivo dell'elettrodo 
sopra il sopracciglio sinistro
• collegare l'elettrodo arancione al cuscinetto

1. posizionare un cuscinetto adesivo dell'elettrodo  
su E1 (occhio sinistro 1 cm di canto esterno,
1 cm inferiore)
• collegare un elettrodo nero al cuscinetto

1. posizionare un cuscinetto adesivo dell'elettrodo 
sul mento
• collegare un elettrodo rosso al cuscinetto

1. posizionare un cuscinetto adesivo su M1, il 
processo mastoideo
• collegare un elettrodo verde (massa) al 

cuscinetto

1. inserire le terminazioni cavi in base al colore 
nella Scatola elettrodi SE

2. inserire la terminazione della Scatola elettrodi 
SE nella porta AUX di MediByte, accertandosi 
che il punto rosso del connettore sia allineato 
con il punto rosso della porta.

Dietro 
l’orecchio

Figura 5.32: Posizionamento dell'elettrodo 
del sonno + EEG



Preparazione del paziente
Avvio dello studio
Quando il paziente ha indossato tutti i sensori e sono state collegate le terminazioni a 
MediByte�MediByte Jr, il registratore è pronto a raccogliere i dati. Se il registratore è impostato 
sull'avvio automatico (consigliato), si avvierà da solo all'ora di inizio indicata. Se il registratore è 
impostato sull'avvio manuale, indicare al paziente di far scorrere l'interruttore di 
accensione�spegnimento della raccolta in posizione ON (punto bianco) al momento di coricarsi. 
L'avvio manuale non è consigliato.

Conclusione dello studio

Ora l'unità è pronta per il recupero dei dati.

Il pulsante evento viene utilizzato per contrassegnare eventi significativi durante la notte. Ad 
esempio, dire al paziente di premere il pulsante evento quando spegne le luci, quando si alza nel 
cuore della notte, quando torna a letto, ecc. I dati conterranno un indicatore di pressione del 
pulsante che verrà visualizzato sullo schermo durante l'analisi dei dati.

Al mattino, chiedere al paziente di premere il pulsante Evento, far scorrere l'interruttore di 
accensione�spegnimento della raccolta in posizione OFF e rimuovere i sensori.
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Capitolo 6: Revisione dei dati

In questo capitolo
In questo capitolo viene descritto come  scaricare i dati da MediByte�MediByte Jr, rivedere i 
dati visualizzati, contrassegnarli con tag evento, contrassegnarli con tag di segnalazione, 
regolare i tag evento e i tag di segnalazione e stampare un report. Non è possibile aprire la 
schermata di visualizzazione dei dati senza i dati memorizzati sul computer o scaricati da 
MediByte�MediByte Jr.

Questo capitolo comprende:

• download dei dati da MediByte�MediByte Jr

• schermata di visualizzazione dei dati

• modifica della lingua utilizzata nel software

• esame dei dati

• segnalazione assistita degli eventi

• segnalazione manuale degli eventi

• Stampa dei report
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Download dei dati da MediByte/MediByte Jr
NON collegare MediByte/MediByte Jr al computer mentre è a contatto con il 
paziente. Questo potrebbe causare gravi lesioni al paziente.

Figura 6.1: Selezionare Download dei dati da MediByte

Figura 6.2: Finestra di download dei dati

1. Se non è ancora stato fatto, scollegare 
MediByte�MediByte Jr dal paziente.

2. Verificare che la batteria sia ancora 
funzionante (il LED di stato lampeggia in 
verde una volta ogni sei secondi).

3. Inserire il cavo USB al computer e quindi a 
MediByte�MediByte Jr.

4. Fare doppio clic sull'icona del software 
MediByte sul desktop per avviare il 
software.

5. Nella finestra Selezione operazione, 
selezionare Download dei dati da 
MediByte (Download data from the 
MediByte). Viene visualizzata una finestra 
informativa per informare che i dati sono 
stati trovati e che MediByte sta eseguendo 
il download dei dati.

• La funzione segnalazione assistita 
elaborerà i dati e genererà eventi di 
segnalazione.

• Al termine del download dei dati viene 
visualizzata la schermata finale della 
procedura guidata. Sullo schermo viene 
visualizzato quanto segue: Accertarsi 
che i dati siano esaminati da un 
professionista qualificato (Please ensure 
the data is reviewed by a qualified 
professional).

1. Fare clic su Fine. Il software visualizzerà i 
dati sullo schermo del computer.
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Aprire un nuovo file di dati

Per aprire un nuovo file di dati:

Figura 6.3: Data manager degli studi

È possibile aprire un altro file di dati dalla schermata di visualizzazione dei dati (Data display 
screen). Quando si apre il nuovo file, il file corrente viene sostituito. Non è possibile avere due 
file di dati aperti contemporaneamente.

1. fare clic su File>Apri (File>Open) per attivare il 
Data manager degli studi (Study Data 
Manager). Il Data manager degli studi 
visualizza i file disponibili nella cartella Test 
predefiniti (Default Tests).

2. Per selezionare una cartella di archiviazione 
diversa, fare clic sul pulsante a discesa       e 
selezionare una nuova cartella.

3. Fare doppio clic sul file di dati che si desidera 
aprire; il nuovo file si apre nella schermata di 
Visualizzazione dei dati.
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Aprire uno Studio senza MediByte
È possibile aprire uno studio senza collegare MediByte al computer.

Per aprire uno studio:

Figura 6.4: Schermata di apertura

1. fare doppio clic sull'icona di MediByte sul 
desktop

2. digitare la password MASTER nel campo 
Password la password è sensibile alle maiuscole 
e deve essere digitata in lettere maiuscole

3. fare clic sul pulsante Analizza uno studio 
(Analyze a study) per aprire la finestra 
Caricamento e revisione (Load and Review)

4. fare doppio clic sullo studio che si desidera 
esaminare in alternativa, fare clic per 
evidenziare lo studio e fare clic su Fine si apre 
la schermata di Visualizzazione dei dati con lo 
studio selezionato.

Figura 6.5: Finestra Caricamento e revisione con un 
file di dati selezionato
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Schermata di visualizzazione dei dati

Figura 6.6: Schermata di Visualizzazione dei dati

Informazioni per il 
paziente

Visualizzare 
l'istogramma

Aprire la finestra dei 
marcatori di eventi

Ridimensionare 
il display

Cancellare un 
marcatore di 
segnalazione

Stampa di un report

Stampa della 
schermata corrente

Ripristinare un 
marcatore 
cancellato

Pulsanti sullo schermo

Contrassegnare 
i dati errati

Contrassegnare e 
riprodurre l'audio

Osservazioni della 
registrazione 

dell'analisi audio FFT

Il software MediByte utilizza un'interfaccia grafica utente (GUI) Windows® Windows®, una 
barra degli strumenti, una barra di stato e un menu a discesa.
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Modifica della lingua utilizzata nel software
È possibile modificare la lingua dalla schermata di Visualizzazione dei dati. Nel software sono 
disponibili le seguenti lingue: arabo, cinese, tedesco, inglese, spagnolo, francese, italiano, 
olandese, polacco, portoghese, rumeno e russo.

Per modificare la lingua utilizzata nel software:

Figura 6.7: Menu di selezione della lingua

1. fare clic su Strumenti>Lingua (Tools>Language) per aprire il menu di selezione della lingua

2. fare clic su una lingua per modificare la lingua utilizzata nel software. È consigliabile riavviare il
software per accertarsi che tutti i campi e le finestre siano tradotti.
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Revisione dei dati

Per rivedere le schermate di dati:

•    o  procedere con i dati di un'intera schermata.

•     o   +  procedere con i dati di mezza schermata.

•    o  tornare indietro nei dati di un'intera schermata.

•   o  +  tornare indietro nei dati di mezza schermata.

•   spostarsi alla prima schermata.

•   spostarsi all'ultima schermata.

Il software MediByte etichetta automaticamente i dati con gli eventi di segnalazione. Rivedere 
i tag di segnalazioni suggeriti sfogliando i dati o visualizzando l'istogramma.
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Revisione dei dati con l'istogramma
È possibile rivedere i dati utilizzando l'istogramma.

Per passare a una schermata di dati dell'istogramma:

Figura 6.8: Fare clic sull'istogramma per visualizzare i dati in modo più dettagliato.

1. Espandere l'istogramma trascinando il limite 
superiore dell'istogramma (cerchiato).

2. Puntare sulla sezione dell'istogramma che si 
desidera visualizzare in modo più dettagliato 
(come sopra) e fare clic. La visualizzazione dei 
dati principali mostra l'area di dati 
selezionata.

Figura 6.9: Trascinare il limite superiore 
dell'istogramma per espanderlo.
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Modifica delle proprietà dell'istogramma

Per modificare le proprietà dell'istogramma:

Figura 6.10: Finestra Impostazioni istogramma

È possibile selezionare il tipo di dati che si desidera visualizzare nell'istogramma utilizzando la 
finestra Impostazioni istogramma (Histogram Settings).

1. fare clic con il tasto destro del mouse sull'istogramma per attivare il pulsante Proprietà 
info istogramma (Histogram Info Properties)

2. fare clic sul pulsante Proprietà Info istogramma per aprire la finestra Impostazioni 
istogramma

3. selezionare il tipo di forma d'onda, il segnale, le unità inferiori e superiori e se si desidera 
visualizzare un'etichetta

4. fare clic su OK.
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ti.

, 
Utilizzo del Navigatore dello studio (Study Navigator)

Navigazione in base all'ora
Questa funzione cerca un momento specifico dello studio. È possibile impostare la limitazione 
sull'ora del giorno o sull'ora dello studio.

 

Navigazione in base al segnale

Figura 6.11: Navigazione in base all'ora

Figura 6.12: Navigazione in base al segnale

Il navigatore dello studio si trova sotto la schermata di Visualizzazione dei dati. Utilizzarlo per 
cercare tra i dati con uno dei seguenti parametri: tempo, segnale o evento segnalato.

1. Fare clic sul pulsante Cerca (Search for) e selezionare Ora.

2. Fare clic sulla sezione dell'ora per evidenziarla e premere le frecce        per modificare l'ora.

3. Fare clic sulla sezione dei minuti per evidenziarla e premere le frecce        per modificare i minu

4. Selezionare la limitazione, ad esempio l'ora del giorno o l'ora dello studio.

5. Selezionare il pulsante di ricerca avanti           o il pulsante di ricerca           indietro.

Questa funzione cerca un segnale specifico nello studio. È possibile impostare la limitazione 
rispetto a un valore percentuale del segnale, al valore minimo o al valore massimo del segnale.

1. Fare clic sul pulsante Cerca e selezionare Segnale (Signal).

2. Fare clic sulla freccia       per selezionare il tipo di segnale.

3. Selezionare la limitazione             . Se è stato inserito una limitazione relazionale (ad esempio, =)
inserire il valore percentuale.

4. Selezionare il pulsante di ricerca avanti           o il pulsante di ricerca           indietro.
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Navigazione in base all'evento segnalato
Questa funzione cerca un evento specifico segnalato nello studio.

Figura 6.13: Navigazione in base all'evento segnalato

1. Fare clic sul pulsante Cerca e selezionare Evento segnalato (Scored Event).

2. Fare clic sulla freccia       per selezionare il tipo di evento segnalato.

3. Selezionare la limitazione.

4. Selezionare il pulsante di ricerca avanti          o il pulsante di ricerca          indietro.
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Barra di stato dello studio
La barra di stato dello studio si trova sotto il navigatore dello studio. La barra di stato dello 
studio fornisce le seguenti informazioni:

Figura 6.14: Barra di stato dello studio

1. misura del segnale: mostra la misura quantitativa di un segnale al passaggio del mouse

2. stato dello studio: per gli studi raccolti utilizzando la versione 9 del software: NON 
CONVALIDATO significa che lo studio è stato valutato dal software, ma non da uno 
specialista. CONVALIDATO significa che ogni periodo tra lo spegnimento e l'accensione 
delle luci è stato esaminato e che almeno un evento è stato modificato. Per gli studi 
raccolti da versioni precedenti del software, questi verranno inizialmente visualizzati come 
NON CONVALIDATI anche se sono stati esaminati nella versione precedente. Dopo aver 
inserito nello studio il nome e le osservazioni del tecnico del sonno, lo stato passerà a 
CONVALIDATO.

3. Indice di risveglio (AI): numero medio di risvegli all'ora. L'AI è riportato solo in uno studio 
che ha registrato il sonno, vale a dire Sonno, Sonno + EEG o Sonno + ECG.

4. Indice di apnea e ipopnea (AHI): numero medio di eventi di apnea e ipopnea per ora di 
sonno. Questo numero viene visualizzato in verde quando l'AHI è inferiore a 15, in giallo 
tra 15 e 30 e in rosso quando l'AHI è maggiore o uguale a 30.

5. RDI: numero medio di episodi di apnee, ipopnee e RERA per ora di sonno. Questo numero 
viene visualizzato in verde quando l'RDI è inferiore a 20, in giallo tra 20 e 40 e in rosso 
quando l'RDI è maggiore o pari a 40.

6. Dati validi: visualizza il numero di minuti di dati validi nello studio.

7. Numero di periodo: visualizza il numero di periodi come numero di periodi del numero 
totale di periodi.

8. Larghezza pagina: visualizza la larghezza della pagina in secondi.



Revisione dei dati
Tag Luci spente/Luci accese

Per contrassegnare i dati:

Figura 6.15: Finestra di selezione di un evento 
utente

Il software MediByte aggiunge automaticamente i tag LUCI SPENTE�LUCI ACCESE durante il 
download iniziale dei dati da MediByte. Il software contrassegna i dati con un tag LUCI SPENTE 
dopo i primi dieci minuti di dati stabili e non stazionari in cui anche il valore SpO2 è stabile e valido. 
Il software contrassegna i dati con un tag LUCI ACCESE, risalendo dalla fine del set di dati ai primi 
cinque minuti di dati stabili e non stazionari, in cui anche il valore di SpO2 è stabile e valido.

Prima di iniziare la revisione dei dati, accertarsi che i dati siano stati contrassegnati con i tag 
LUCI SPENTE e LUCI ACCESE. Se il paziente ha premuto il pulsante Evento su MediByte al 
momento di coricarsi e al risveglio, nei dati saranno presenti tag di pressione dei pulsanti. 
Inserire i tag LUCI SPENTE e LUCI ACCESE nel punto in cui si trovano i tag di pressione dei 
pulsanti, quindi rimuovere i tag inseriti dal software. Vedere "Eliminazione dei marcatori di 
eventi" a pagina 6-20.

1. All'inizio del set di dati, fare doppio clic sui dati 
per attivare la finestra Seleziona un evento 
utente (Select a User Event).

2. Fare clic sul pulsante LUCI SPENTE per inserire 
un tag Luci Spente nei dati.

3. Alla fine del set di dati, fare doppio clic sui dati 
per attivare la finestra Seleziona un evento 
utente.

4. Fare clic sul pulsante LUCI ACCESE per inserire 
un tag Luci Accese nei dati.
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9. Nel campo Girovita (Waist), inserire la misura del girovita del paziente in pollici (in.) o 
centimetri (cm), utilizzando numeri interi. Il software calcola il valore corrispondente.

10. Nel campo Fianco (Hip), inserire la misura del fianco del paziente in pollici (in.) o centimetri 
(cm), utilizzando numeri interi. Il software calcola il valore corrispondente. Una volta 
inserite le misure di girovita e fianchi, il software MediByte calcola il rapporto 
girovita-fianchi.

11. Fare clic su Maschio (Male) o Femmina (Female).

12. Nel campo Medico di riferimento (Referring Physician), digitare il nome del medico 
di riferimento, se necessario.

13. Nel campo Farmaci (Medications), digitare tutti i farmaci utilizzati dal paziente.

14. Fare clic su Salva (Save) e poi su OK per salvare il file del paziente.
Informazioni per il paziente

Per rivedere e aggiungere informazioni sul paziente

Figura 6.16: Schermata Info paziente

È possibile aprire la schermata Info paziente e aggiungere ulteriori informazioni sul paziente. 
Poiché la procedura guidata MediByte accetta solo il nome, il cognome, l'ID del paziente e il 
peso, è probabile che siano necessarie altre informazioni sul paziente.

1. Fare           clic per aprire la finestra 
Informazioni paziente.

2. Nel campo Codice (Code), digitare un codice 
paziente univoco, come richiesto.

3. Nel campo Cognome (Last Name) e Nome 
(Surname), verificare che i nomi siano 
corretti.

4. Nel campo SOC�SIN, digitare il numero di 
previdenza sociale (SOC)�numero di 
assicurazione sociale (SIN) del paziente.

5. Nel campo DOB (Data di nascita), fare clic 
sulla parte della data che si desidera 
modificare, quindi digitare il mese, la data o 
l'anno desiderati.

6. Nel campo Altezza (Height), digitare l'altezza 
del paziente in piedi (ft.) e pollici (in.) o in 
centimetri (cm) usando numeri interi. Il 
software calcola il valore corrispondente.

7. Nel campo Peso (Weight), digitare il peso 
del paziente in libbre (lbs.) o chilogrammi 
(kg) utilizzando numeri interi. Il software 
calcola il valore corrispondente.
Una volta inseriti i valori di altezza e peso, il 
software MediByte calcola l'indice di massa 
corporea (BMI).

8. Nel campo Circonferenza del collo (Neck 
Circumference), inserire la circonferenza del 
collo del paziente in piedi (ft.) e pollici (in.) o 
centimetri (cm) utilizzando numeri interi. Il 
software calcola il valore corrispondente.



1. Fare           clic per aprire la finestra 
Informazioni paziente.

2. Nel campo Codice (Code), digitare un codice 
paziente univoco, come richiesto.

3. Nel campo Cognome (Last Name) e Nome 
(Surname), verificare che i nomi siano 
corretti.

4. Nel campo SOC�SIN, digitare il numero di 
previdenza sociale (SOC)�numero di 
assicurazione sociale (SIN) del paziente.

5. Nel campo DOB (Data di nascita), fare clic 
sulla parte della data che si desidera 
modificare, quindi digitare il mese, la data o 
l'anno desiderati.

6. Nel campo Altezza (Height), digitare l'altezza 
del paziente in piedi (ft.) e pollici (in.) o in 
centimetri (cm) usando numeri interi. Il 
software calcola il valore corrispondente.

7. Nel campo Peso (Weight), digitare il peso 
del paziente in libbre (lbs.) o chilogrammi 
(kg) utilizzando numeri interi. Il software 
calcola il valore corrispondente.
Una volta inseriti i valori di altezza e peso, il 
software MediByte calcola l'indice di massa 
corporea (BMI).

8. Nel campo Circonferenza del collo (Neck 
Circumference), inserire la circonferenza del 
collo del paziente in piedi (ft.) e pollici (in.) o 
centimetri (cm) utilizzando numeri interi. Il 
software calcola il valore corrispondente.

Revisione dei dati
9. Nel campo Girovita (Waist), inserire la misura del girovita del paziente in pollici (in.) o 
centimetri (cm), utilizzando numeri interi. Il software calcola il valore corrispondente.

10. Nel campo Fianco (Hip), inserire la misura del fianco del paziente in pollici (in.) o centimetri 
(cm), utilizzando numeri interi. Il software calcola il valore corrispondente. Una volta 
inserite le misure di girovita e fianchi, il software MediByte calcola il rapporto 
girovita-fianchi.

11. Fare clic su Maschio (Male) o Femmina (Female).

12. Nel campo Medico di riferimento (Referring Physician), digitare il nome del medico 
di riferimento, se necessario.

13. Nel campo Farmaci (Medications), digitare tutti i farmaci utilizzati dal paziente.

14. Fare clic su Salva (Save) e poi su OK per salvare il file del paziente.

*Lancet, 2005 November; 366 (9497) 1640-9; Obesity and the risk of myocardial infarction on 27,000 
participants from 52 countries: a case-control study.  Yusuf, Hawken et al.

Tabella 6-1: Grafico del rapporto girovita/fianchi*

Uomo Donna

Basso rischio

Rischio moderato

Alto rischio

Rischio per la salute 
basato esclusivamente 
sul WHR
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Ridimensionamento del display

To scale the display:

Figura 6.17: Dati prima e dopo il ridimensionamento

• fare clic su           per ridimensionare il display. La 
figura a destra mostra la stessa visualizzazione 
dei dati prima e dopo il ridimensionamento.

Quando i dati vengono visualizzati per la prima volta sullo schermo, le forme d'onda possono 
apparire piatte. È possibile ridimensionare il display per migliorare l'aspetto delle forme d'onda. 
Il ridimensionamento prende i valori massimi e minimi delle forme d'onda e regola 
proporzionalmente i limiti superiore e inferiore delle forme d'onda. Il ridimensionamento 
modifica l'aspetto della visualizzazione, ma non i dati.
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e

Modifica dell'aspetto di un segnale

Per ridimensionare un canale:

Per invertire un canale:

Per visualizzare la lettura digitale di un canale:

Per modificare il colore del canale:

Figura 6.20: ECG prima e dopo l'inversione

Figura 6.21: Lettura digitale dell'ECG

È possibile modificare il modo in cui un segnale viene visualizzato sullo 
schermo utilizzando il menu delle proprietà del segnale. Nel menu delle 
proprietà del segnale è possibile selezionare ridimensionamento, 
inversione, digitale e colore. La modifica dell'aspetto del segnale con il 
menu delle proprietà del segnale non modifica i dati, ma solo il modo 
in cui vengono visualizzati sullo schermo. Figura 6.18: Menu 

delle proprietà del 
segnale del canale 
Frequenza del polso

1. fare clic con il tasto destro del mouse su un 
canale per aprire il menu delle proprietà del 
segnale

2. fare clic su Ridimensionare (Scale) per selezionare 
il canale da ridimensionare.

3. Fare clic su          . Figura 6.19: Segnale prima e dopo il 
ridimensionamento

1. fare clic con il tasto destro del mouse su un canale 
per aprire il menu delle proprietà del segnale

2. fare clic su Inverti (Invert) per invertire il canale.

1. fare clic con il tasto destro del mouse su un canale 
per aprire il menu delle proprietà del segnale

2. Fare clic su Digitale per visualizzare la lettura digitale 
del canale.

1. fare clic con il tasto destro del mouse su un canale per aprire il menu delle proprietà del segnal

2. fare clic su Colore (Color) per aprire il menu colori
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3. fare clic su un colore e selezionare OK.



1. fare clic con il tasto destro del mouse su un canale per aprire il menu delle proprietà del segnale

2. fare clic su Colore (Color) per aprire il menu colori

3. fare clic su un colore e selezionare OK.
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Per visualizzare l'ora effettiva sul display

Per modificare la sensibilità di un canale:

1. Fare clic con il tasto destro del mouse su un canale 
per aprire il menu delle proprietà del segnale.

2. Facendo clic su Ora, l'ora effettiva della registrazione 
viene visualizzata nella parte inferiore del display.

Figura 6.22: Flusso prima e dopo la modifica 
della sensibilità

1. tenere premuto il tasto di controllo e fare doppio 
clic con il tasto sinistro del mouse. Il segnale 
diventa giallo.

2. Utilizzare i tasti freccia in alto e in basso o la 
rotellina del mouse per modificare l'ampiezza del 
segnale. I dati in sé non cambiano, ma cambia solo 
il modo in cui vengono visualizzati sullo schermo.

3. Quando l'aspetto del segnale è soddisfacente, fare 
clic sul display e il segnale tornerà a essere 
visualizzato.
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Passaggio ai marcatori degli eventi

Per passare a un marcatore degli eventi:

Inserimento di marcatori degli eventi utente

Per inserire un marcatore degli eventi:

Per inserire un tag per la pressione CPAP:

Visualizzare un elenco di marcatori degli eventi nella finestra Marcatori degli eventi (Event 
Markers). Facendo doppio clic su un marcatore degli eventi, si passa alla schermata per 
visualizzare l'evento in modo più dettagliato.

1. fare clic su           per aprire la finestra Marcatori degli 
eventi

2. fare doppio clic sul marcatore degli eventi appropriato 
nell'elenco per passare al periodo con il marcatore degli 
eventi selezionato.

Figura 6.23: Finestra dei marcatori 
degli eventi

Durante la revisione di uno studio, è possibile inserire ulteriori marcatori degli eventi facendo 
doppio clic sui dati e inserendo un nuovo evento utente. Il software MediByte inserisce nei dati 
una linea verticale e un tag dell'evento utente. Se si dispone di uno studio CPAP, è possibile 
inserire un tag per la pressione CPAP.

1. andare al periodo in cui si vuole inserire un evento utente

2. posizionare il mouse su una parte vuota (bianca) del 
display e fare doppio clic per aprire la finestra Seleziona 
un evento utente (Select a User Event)

3. fare clic per selezionare il pulsante dell'evento utente 
appropriato o digitare una descrizione dell'evento utente 
e fare clic su Seleziona (Select).

1. andare al  periodo in cui si vuole inserire un tag per la 
pressione CPAP

2. posizionare il mouse e fare doppio clic per aprire la 
finestra Seleziona un evento utente.

3. Fare clic sulle frecce in alto e in basso per selezionare il 

Figura 6.24: Selezionare una finestra 
evento utente
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Figura 6.25: Selezionare un evento 
utente CPAP

livello di pressione appropriato. fare clic su CPAP. I tag 
CPAP sono disponibili solo negli studi in cui è stato 
registrato un segnale CPAP.
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Eliminazione dei marcatori degli eventi

Per eliminare un marcatore degli eventi:

Figura 6.26: Eliminazione di 
un marcatore degli eventi

È possibile eliminare i marcatori degli eventi indesiderati da uno studio. Invece di cercare tra i 
dati i marcatori degli eventi che si vogliono eliminare, utilizzare la finestra dei marcatori degli 
eventi per eliminare i marcatori degli eventi indesiderati.

1. fare clic su           per aprire la finestra Marcatori degli 
eventi

2. selezionare l'evento che si vuole eliminare dall'elenco

3. fare clic con il tasto destro del mouse sull'evento 
nell'elenco per attivare le impostazioni del filtro eventi

4. Fare clic su Elimina (Delete).
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Eliminazione dei marcatori degli eventi

Per eliminare un marcatore degli eventi:

Figura 6.27: Finestra delle Osservazioni/Commenti

È possibile eliminare i marcatori degli eventi indesiderati da uno studio. Invece di 
cercare tra i dati i marcatori degli eventi che si vogliono eliminare, utilizzare la 
finestra dei marcatori degli eventi per eliminare i marcatori degli eventi indesiderati.

1. fare clic           per aprire la finestra 
Osservazioni�Commenti

2. utilizzare le schede per selezionare la 
qualifica professionale

3. digitare le osservazioni e fare clic su OK.
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Visualizzazione del segnale del fotopletismografo
È possibile visualizzare il segnale raccolto del fotopletismografo (PPG) selezionando il segnale 
del fotopletismografo dal menu a discesa Visualizza (View). Il segnale PPG è una misurazione 
volumetrica del sangue all'interno dei vasi sottocutanei della punta del dito o del lobo 
dell'orecchio, in base al sito utilizzato per la registrazione MediByte (ad es. cavo polpastrello 
SpO2 per MediByte o cavo SpO2 lobo per MediByte). Il pulsossimetro MediByte raccoglie il 
segnale illuminando la cute con luce infrarossa. Il sangue viene pompato in tutto il corpo e 
verso la periferia a ogni ciclo cardiaco. L'impulso di pressione, anche se attenuato, è sufficiente 
quando raggiunge la periferia per distendere i vasi sottocutanei sotto la cute. Come mostrato 
nelle figure 6.28 e 6.29, le contrazioni ventricolari premature (PVC) possono essere facilmente 
rilevabili all'interno della forma d'onda del PPG e il PPG può essere utile per rilevare alcune 
aritmie cardiache quando non si utilizza il montaggio dell'ECG MediByte.

• Per visualizzare il segnale del fotopletismografo, 
fare clic su Visualizza>Segnale fotopletismografo 
(View>photoplethysmograph Signal).

Il segnale viene riportato nella parte inferiore 
del display dei dati.

Figura 6.28: PVC sul segnale PPG ed ECG 

Figura 6.29: PVC su PPG, frequenza del polso 
ed ECG
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Segnalazione assistita degli eventi

Quando esegue il download del file di dati, segnala automaticamente gli eventi con 
marcatori di segnalazione degli eventi. I marcatori degli eventi di segnalazione sono barre 
colorate con le abbreviazioni degli eventi di segnalazione negli angoli in alto a destra delle 
barre. Se si dispone di uno studio CPAP, il software etichetterà automaticamente le 
variazioni di pressione CPAP dopo aver effettuato il download dei dati.

Per informazioni sulla marcatura errata di SpO2�pulsazioni, vedere Contrassegnare i dati 
errati a pagina 6- 43.

Figura 6.30: Eventi segnalati (SSD, SNR e ipopnea)

Il software MediByte ha uno strumento di segnalazione assistita per etichettare 
automaticamente i dati errati relativi a SpO2�pulsazioni, desaturazione, respiratori, RERA e 
resistenza delle vie aree superiori. Inoltre, i dati raccolti con MediByte possono anche 
visualizzare la variabilità della frequenza del polso, l'ECG, il bruxismo e i tag degli eventi
di movimento degli arti.

È possibile utilizzare il menu Strumenti (Tools) per eliminare i marcatori degli eventi di segnalazione, 
modificare le regole di segnalazione e attribuire nuovamente una segnalazione ai dati.
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Modifica delle regole di segnalazione assistita

Per modificare le impostazioni di segnalazione assistita:

Utilizzare la finestra Configurazione delle regole di segnalazione assistita (Assisted Rules Setup) 
per modificare le regole di segnalazione assistita. Se il modo in cui il software segnala i dati è 
soddisfacente, ignorare questa finestra. È possibile modificare i parametri per le desaturazioni, 
gli eventi respiratori, la variabilità della frequenza del polso, gli eventi di resistenza delle vie 
aeree superiori e i movimenti degli arti.

1. selezionare Strumenti>Impostazioni segnalazione assistita (Tools>Assisted Scoring 
Settings) per aprire la schermata Configurazione regole assistite (Assisted Rules Setup)

2. impostare le condizioni per la segnalazione degli eventi:

• per Desaturazione (Desaturation), impostare il calo minimo del segnale necessario per 
segnalare l'evento come desaturazione

• per gli Eventi respiratori (Respiratory Events), impostare la durata minima di un evento, la 
riduzione minima del flusso necessaria per segnalare un'apnea e un'ipopnea e la riduzione 
minima dello sforzo necessaria per segnalare un'apnea e un'ipopnea è inoltre possibile 
selezionare la segnalazione automatica RERA (risveglio correlato allo sforzo respiratorio)

• per la Variabilità della frequenza del polso (solo MediByte), impostare la variazione minima 
richiesta in battiti al minuto; la durata minima e massima dell'evento

• per gli Eventi di resistenza delle vie aeree superiori: russamento (audio), russamento 
(flusso) e limitazione del flusso, impostare il limite inferiore del volume del russamento in 
dB, impostare la durata del russamento e utilizzare il cursore per regolare la sensibilità del 
rilevatore di soglia per segnalare più o meno eventi

• per il Movimento degli arti (solo MediByte), impostare il tempo massimo tra i movimenti da 
segnalare come entrambi, selezionare i canali da usare per rilevare i movimenti degli arti e usare 
il cursore per regolare la sensibilità del rilevatore di soglia per segnalare più o meno eventi

1. fare clic su OK.
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Figura 6.31: Schermata Configurazione regole assistite
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Avvio della segnalazione assistita

Si consiglia di eseguire la segnalazione assistita per la respirazione se sono state apportate 
modifiche alla segnalazione della desaturazione nei dati.

Figura 6.33: Istogramma che mostra gli eventi segnalati

Lo strumento di segnalazione assistita etichetterà automaticamente i dati con dati errati 
SpO2�pulsazioni, desaturazione, respirazione, RERA, resistenza delle vie aeree superiori. Inoltre, 
con i dati raccolti con MediByte è possibile visualizzare la variabilità della frequenza del polso, 
l'ECG, il bruxismo e i tag dei movimenti degli arti. È possibile selezionare fino a otto tipi di eventi 
per la segnalazione e la parte dello studio da segnalare.

La disponibilità della segnalazione assistita dipende dai segnali raccolti. Ad esempio, nella figura 
riportata qui di seguito, i canali degli arti, ECG e bruxismo non sono stati raccolti e quindi non 
sono disponibili.

1. Selezionare Strumenti>Segnalazione assistita (Tools>Assisted 
Scoring) per attivare la schermata Segnalazione assistita.

2. Selezionare il tipo di eventi che il programma deve segnalare.

3. Fare clic su Vai per avviare la segnalazione assistita. Sullo 
schermo viene visualizzata una barra di avanzamento mentre 
il software calcola le posizioni degli eventi. Quando la 
segnalazione automatica è terminata, la barra di avanzamento 
scompare.

4. Rivedere gli eventi segnalati utilizzando l'istogramma. Si 
possono modificare manualmente gli eventi segnalati, come 
indicato a pagina 6- 28.

Figura 6.32: Finestra di 
segnalazione assistita
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Eliminazione di eventi segnalati

Per eliminare tutti i marcatori degli eventi di segnalazione dal set di dati:

Figura 6.34: Finestra 
Rimuovere Eventi segnalati

Figura 6.35: Istogramma prima della rimozione degli eventi UARS

Figura 6.36: Istogramma dopo la rimozione degli eventi UARS

È possibile eliminare tutti o alcuni degli eventi segnalati da un set di dati utilizzando la funzione 
Elimina eventi segnalati. Il software elimina solo gli eventi segnalati tra i marcatori degli eventi 
Luci spente e Luci accese, a eccezione del caso in cui venga selezionato Intero studio. Se non ci 
sono marcatori di eventi Luci spente e Luci accese, , la selezione di Intero studio eliminerà 
automaticamente tutti i marcatori di eventi dall'intero set di dati.

Se si vogliono rimuovere uno o due marcatori di eventi segnalati, fare clic con il pulsante 
destro del mouse su un marcatore e selezionare Rimuovi questo evento (Remove This Event).

1. fare clic su Strumenti>Elimina eventi segnalati (Tools>Delete 
Scored Events) per aprire la schermata Rimuovi eventi segnalati 
(Remove Scored Events)

2. fare clic sul tipo di eventi che si vogliono rimuovere dai dati

3. fare clic su Intero studio (Entire Study) se si vogliono eliminare 
tutti gli eventi, oppure deselezionare Intero studio e inserire un 
intervallo di tempo.

4. Fare clic su Vai. Una finestra di avviso chiederà di verificare se si 
vogliono eliminare gli eventi segnalati; fare clic su Sì per 
continuare. Quando il programma ha terminato l'eliminazione 
degli eventi segnalati, l'istogramma non mostrerà alcun evento 
segnalato del tipo rimosso.
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Segnalazione manuale degli eventi

Nota: Non è possibile aggiungere marcatori di eventi di segnalazione ai periodi 
segnalati come Veglia. Se la fase di sonno di un periodo viene modificata da una 
fase di sonno a fase di veglia, tutti gli eventi contrassegnati all'interno del periodo 
verranno nascosti.

Tabella 6-2: Marcatori di eventi di segnalazione

Abbreviazione Nome e cognome Tipo Canale

CA

OA

MA

HY

CH

SuH

RERA

CS

D

PRV

A

RA

SA

DA

SSD

Apnea centrale

Apnea ostruttiva

Apnea mista

Ipopnea

Ipopnea centrale

Sub-ipopnea

Risveglio correlato alla 
respirazione

Chenyne-Stokes

Desaturazione

Variabilità della frequenza 
del polso
Risveglio

Risveglio respiratorio

Risveglio russamento

Risveglio desaturazione

Suono del russamento

Assistita o manuale

Assistita o manuale

Assistita o manuale

Assistita o manuale

Assistita o manuale

Assistita o manuale

Assistita o manuale

Solo manuale

Assistita o manuale

Assistita o manuale

Solo manuale

Solo manuale

Solo manuale

Solo manuale

Assistita o manuale

Flusso, ThFlow Somma

Flusso, ThFlow Somma

Flusso, ThFlow Somma

Flusso, ThFlow Somma

Flusso, ThFlow Somma

Petto e addome

Torace e addome

Torace e addome

SpO2

Polso

EEG

EEG

EEG

EEG

Russamento (audio)

In MediByte Software, i marcatori degli eventi di segnalazione sono barre colorate con le 
abbreviazioni degli eventi di segnalazione negli angoli in alto a destra del display. La tabella 
riportata qui di seguito mostra tutte le abbreviazioni disponibili per i marcatori di eventi di 
segnalazione, i loro nomi completi e il canale associato a ciascun evento. Per una descrizione 
di ciascun tipo di evento segnalato, consultare il glossario.
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SNR Resistenza da russamento nasale

Limitazione del flusso

Asistole

Bradicardia

Tachicardia a complessi 
stretti

Tachicardia a complessi larghi

Tachicardia sinusale

Fibrillazione ventricolare

Fibrillazione atriale

Contrazioni ventricolari 
premature

Contrazioni atriali premature

Movimento degli arti

Bruxismo

Dati SpO2 errati

Dati errati, tutti i canali

Assistita o manuale

Assistita o manuale

Solo manuale

Solo manuale

Solo manuale

Solo manuale

Solo manuale

Solo manuale

Solo manuale

Solo manuale

Solo manuale

Assistita o manuale

Assistita o manuale

Assistita o manuale

Solo manuale

Russamento (flusso)

Russamento (flusso)

ECG

ECG

ECG

ECG

ECG

ECG

ECG

ECG

ECG

Gambe (entrambe)

Brux

SpO2, Pulsazione

Tutti

FL

ASY

BRY

NTY

WTY

STY

VFB

AFB

PVC

PAC

LM

BRUX

BAD_SPO2

BAD_ALL

Tabella 6-2: Marcatori di eventi di segnalazione

Abbreviazione Nome e cognome Tipo Canale
  6-29



6-30

Revisione dei dati
Segnalazione delle apnee e delle ipopnee

Segnalare un'apnea quando si verifica quanto segue:

Esistono tre tipi di apnea notturna: ostruttiva, centrale e mista.

Apnea ostruttiva: disturbo respiratorio 
caratterizzato da brevi interruzioni della 
respirazione durante il sonno. Nell'apnea 
ostruttiva, i muscoli del palato molle intorno 
alla base della lingua e dell'ugola si rilassano, 
ostruendo le vie aeree. L'apnea ostruttiva del 
sonno è caratterizzata dalla presenza di sforzi 
respiratori.

Apnea centrale: disturbo respiratorio 
caratterizzato da brevi interruzioni della 
respirazione durante il sonno. L'apnea centrale 
si verifica quando il cervello non invia i segnali 
appropriati ai muscoli respiratori per avviare la 
respirazione; l'apnea centrale del sonno è 
quindi caratterizzata dalla mancanza di sforzo 
respiratorio. L'apnea centrale del sonno è 
meno comune rispetto all'apnea ostruttiva del 
sonno.

L'apnea è definita come un'interruzione della respirazione. L'ipopnea è definita come una 
respirazione meno profonda o più lenta del normale. L'ipopnea si distingue dall'apnea, nella 
quale non c'è respirazione.

a. un calo dell'ampiezza del flusso d'aria > 90% del valore basale
b. la durata è di dieci secondi o superiore
c. almeno il 90% della durata dell'evento soddisfa il criterio di riduzione dell'ampiezza.

Figura 6.37: Apnea ostruttiva (dimensione del periodo 
di 90 secondi)

Figura 6.38: Apnea centrale (dimensione del periodo di 
90 secondi)
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Apnea mista: disturbo respiratorio 
caratterizzato da brevi interruzioni della 
respirazione durante il sonno. L'apnea notturna 
mista è costituita da apnea notturna centrale e 
ostruttiva.

Segnalare un'ipopnea quando si verifica quanto segue:

Apnea mista: appiattimento o plateau della 
forma d'onda inspiratoria. Questo appiattimento 
indica una maggiore resistenza del flusso d'aria 
attraverso le vie aeree superiori ed è spesso 

Figura 6.39: Apnea mista (dimensione del periodo di 
90 secondi)

a. l'ampiezza del flusso d'aria diminuisce di ≥ 
30% rispetto al valore basale

b. la durata è di dieci secondi o superiore
c. è presente una desaturazione ≥ 4% rispetto 

al valore basale pre-evento
d. almeno il 90% della durata dell'evento 

soddisfa il criterio di riduzione dell'ampiezza 
per l'ipopnea

       O
a. l'ampiezza del flusso d'aria diminuisce di ≥ 

50% rispetto al valore basale
b. la durata è di dieci secondi o superiore
c. è presente una desaturazione ≥ al 3% 

rispetto al valore basale pre-evento O 
l'evento è associato a un risveglio

d. almeno il 90% della durata dell'evento 
soddisfa il criterio di riduzione dell'ampiezza 
per l'ipopnea.

Figura 6.40: Ipopnea: notare la desaturazione che la 
accompagna
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associato al russamento e alla sindrome di 
resistenza delle vie aeree superiori (UARS).
 

Figura 6.41: Limitazione del flusso
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Risveglio correlato allo sforzo respiratorio (RERA): 
Respiri della durata di almeno 10 secondi 
caratterizzati da un aumento dello sforzo 
respiratorio o da un appiattimento della pressione 
della cannula nasale che portano a un risveglio dal 
sonno quando la sequenza di respiri non soddisfa i 
criteri di un'apnea o di un'ipopnea. La RERA è una 
forma più lieve di disturbo respiratorio del sonno 
rispetto all'apnea o all'ipopnea.

Variabilità della frequenza del polso (PRV):  
Variazione dell'intervallo di tempo tra i battiti 
cardiaci. È possibile impostare le regole per la 
PRV nella schermata Regole di segnalazione 
assistita. L'impostazione predefinita per la PRV 
prevede una variazione minima di sei battiti al 
minuto per una durata minima di un secondo e 
massima di 60 secondi. La PRV è contrassegnata 
da una barra nera sopra il segnale del polso.

Figura 6.42: RERA

Figura 6.43: PRV
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Inserimento dei marcatori degli eventi di segnalazione

Per inserire un marcatore di evento di segnalazione:

I marcatori degli eventi di segnalazione non possono essere sovrapposti.

Figure 6.44: Shortcut menu

1. puntare sulla parte della forma d'onda che si desidera segnalare

2. tenere premuto il pulsante sinistro del mouse mentre si sposta il mouse sulla forma d'onda 
fino alla fine dell'area e rilasciare il pulsante sinistro: questa azione si chiama trascinamento il 
menu di scelta rapida appare quando si rilascia il pulsante del mouse

3. dal menu di scelta rapida, fare clic sull'evento di segnalazione appropriato.

4. Per gli eventi successivi sulla stessa forma d'onda, puntare sulla parte della forma d'onda che 
si desidera segnalare e trascinare il mouse; il software marcherà automaticamente l'evento 
con lo stesso marcatore dell'evento precedente.
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Eliminazione dei marcatori di segnalazione degli eventi

Per eliminare i marcatori di segnalazione degli eventi:

Ripristino dei marcatori di segnalazione degli eventi cancellati

Non appena si cancella un marcatore di evento di segnalazione in modalità di cancellazione, il 
pulsante Annulla diventa disponibile. Ripristinare i marcatori di segnalazione eliminati 

facendo clic sul pulsante Annulla         .

La funzione Annulla consente di ripristinare i marcatori di segnalazione degli eventi a partire 
dall'ultimo marcatore di segnalazione degli eventi cancellato fino al momento in cui è stata 
attivata la modalità di cancellazione. Quando non è possibile ripristinare altri marcatori di 
segnalazione degli eventi, il pulsante Annulla non è disponibile.

Per ripristinare i marcatori di segnalazione degli eliminati:

1. Andare al periodo con il marcatore dell'evento di segnalazione da eliminare.

2. Fare clic su           per attivare la modalità di cancellazione.

3. Fare clic sul marcatore o sui marcatori dell'evento di segnalazione che si vogliono eliminare.

4. Al termine, fare clic su          per disattivare la modalità di eliminazione.

È possibile eliminare i marcatori di segnalazione degli eventi utilizzando la modalità di 
eliminazione. Per passare alla modalità di eliminazione, selezionare e deselezionare il pulsante 

Elimina          nella barra degli strumenti.

In modalità di eliminazione, eliminare i marcatori di segnalazione degli eventi facendo clic su di 

essi; ripristinare i marcatori eliminati facendo clic sul pulsante Annulla (Undo)         . Il software 
rimane in modalità di eliminazione fino a quando non si deseleziona il pulsante Elimina (Delete).

Per eliminare un singolo marcatore di segnalazione, fare clic con il pulsante destro del mouse sul 
marcatore e selezionare Rimuovi questo evento (Remove This Event) dal menu di scelta rapida; 
tuttavia, non è possibile comunque annullare i marcatori di eventi eliminati quando si utilizza il 
metodo clic destro.

È possibile ripristinare i marcatori di segnalazione degli eventi eliminati solo se sono stati 
eliminati utilizzando la modalità di eliminazione; non è possibile ripristinare gli eventi eliminati 
facendo clic con il pulsante destro del mouse sul marcatore e selezionando Rimuovi questo 
evento dal menu di scelta rapida.
• Fare clic           il numero di volte necessario per ripristinare gli eventi eliminati in precedenza.
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Modifica dei marcatori di segnalazione degli eventi

Per modificare un marcatore di evento di segnalazione:

Riposizionamento dei marcatori  di 
segnalazione degli eventi

Per riposizionare un indicatore di segnalazione degli eventi:

I marcatori di segnalazione degli eventi non possono essere sovrapposti.

Figura 6.45: Modificare un marcatore 
di segnalazione degli eventi

Con tutti i marcatori di segnalazione degli eventi, è possibile modificare l'evento di segnalazione 
in qualsiasi momento facendo clic con il pulsante destro del mouse sul marcatore e selezionando 
un nuovo evento di segnalazione dal menu di scelta rapida.

1. andare al periodo con il marcatore dell'evento di 
segnalazione da modificare

2. fare clic con il pulsante destro del mouse sul 
marcatore dell'evento di segnalazione e dal menu di 
scelta rapida fare clic sull'evento di segnalazione 
appropriato.

È possibile modificare la posizione di un indicatore 
dell'evento di segnalazione in qualsiasi momento facendo 
clic sull'indicatore e trascinandolo in una nuova posizione.

1. andare al periodo con il marcatore di segnalazione degli 
eventi che si desidera riposizionare

2. fare clic sul marcatore di segnalazione degli eventi e 
trascinarlo nella nuova posizione.
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Allungare o accorciare i marcatori di segnalazione degli eventi

Per allungare o accorciare un marcatore di segnalazione 
degli eventi:

È possibile modificare la lunghezza di un marcatore degli eventi di segnalazione in qualsiasi 
momento posizionando il puntatore sul bordo sinistro o destro del marcatore di segnalazione 
degli eventi  e trascinando il bordo.

1. andare al periodo con il marcatore di segnalazione 
degli eventi che si desidera allungare o accorciare

2. puntando sul bordo destro o sinistro del marcatore 
di segnalazione degli eventi, verrà visualizzata una 
freccia a due punte [     ].

3. Trascinare il bordo per allungare o accorciare il 
marcatore. Figura 6.46: Freccia a due punte sull'evento
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Valutazione delle fasi del sonno (solo MediByte)

L'ipnogramma apparirà nell'istogramma mentre durante la segnalazione dei dati.

Per inserire un marcatore della fase del sonno:

È possibile aggiungere le segnalazioni degli stadi del sonno solo ai dati raccolti 
con le modalità Sonno, Sonno + ECG o Sonno + EEG. I dati visualizzeranno 
EEG, EOG ed EMG.

Tabella 6-3: Tasti della fase del sonno

Fase del sonno Tastiera Visualizzato

Insonnia                         W, A or 0 W

Fase 1                       1 N1

Fase 2                       2 N2

Fase 3                       3 N3

REM 4, 5 o R              R

Movimento M M

È possibile segnalare manualmente le fasi del sonno sullo schermo utilizzando la tastiera del 
computer. Per segnalare le fasi del sonno, impostare l'ampiezza dello schermo su 30 secondi. 
Premere il tasto di scelta rapida corrispondente alla fase del sonno che si sta visualizzando. Per 
esempio, segnalare la fase REM premendo il tasto 5. Premendo il tasto di scelta rapida per la 
fase del sonno, si inserisce una filigrana con l'abbreviazione della fase del sonno nell'angolo in 
alto a destra del display.

1. impostare l'ampiezza dello schermo su 30s

2. fare clic sul tasto corrispondente alla fase del sonno lo schermo passa al periodo successivo, 
per poter segnalare rapidamente i dati

3. fare clic sulla freccia indietro per visualizzare il marcatore di segnalazione della fase del 
sonno in alto a destra dello schermo.
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Contrassegnare manualmente i risvegli (solo MediByte)

Per contrassegnare un risveglio:

Per rimuovere un risveglio:

Figura 6.47: Menu Risveglio

Figura 6.48: Rimozione di un risveglio

Nei dati raccolti utilizzando una delle tre modalità del sonno, è possibile contrassegnare 
manualmente i risvegli sull'EEG.

1. fare clic e trascinare il mouse lungo il segnale EEG per 
contrassegnare il risveglio si aprirà un menu risveglio

2. selezionare il tag risveglio appropriato facendo clic 
con il mouse.

1. fare clic con il tasto destro del mouse su un 
marcatore di risveglio per aprire il menu Risveglio 
(Arousal)

2. fare clic su Rimuovi questo evento (Remove This 
Event) per eliminare il risveglio dai dati.
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Contrassegnare e riprodurre l'audio

È possibile contrassegnare e riprodurre l'audio sul canale AUDIO utilizzando il pulsante 

Contrassegna e riproduci audio (Mark and Play Audio)          . Questo pulsante attiva la funzione 
audio in modo da poter contrassegnare un segmento del canale AUDIO e ascoltare i suoni 
registrati. Questa funzione è utile per distinguere il russamento da altri rumori che si verificano 
durante la notte. Al termine della riproduzione del segmento, l'indicatore giallo scompare; i dati 
non sono contrassegnati in modo permanente. Consultare la Tabella 6-4 a pagina 6-40 per un 
elenco dei livelli di decibel dei suoni comuni.

Per contrassegnare e riprodurre l'audio:

Figura 6.49: Utilizzo della funzione audio

1. fare clic su           per attivare la funzione audio

2. fare clic e trascinare il mouse lungo il canale AUDIO per ascoltare quel segmento di dati se si fa
clic in un altro punto dei dati, la riproduzione audio terminerà

3. fare di nuovo clic           per disattivare la funzione audio.
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Tabella 6-4: Tabella di confronto della rumorosità

Rumore ambientale Livello di decibel (dB)

54-04

07-06

08

58

09

59

90-95

701

011

521

521

041

081

491

Sussurro

Conversazione normale

Tono di chiamata del telefono

Traffico cittadino (all'interno dell'auto)

Fischio di treno a 500'

Metropolitana a 200'

Livello a cui l'esposizione prolungata può provocare la perdita dell'udito

Falciatrice elettrica

Sega elettrica

Inizia il dolore

Flusso pneumatico a 4'

Motore a reazione a 100'

Morte del tessuto uditivo

Suono più forte possibile
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Contrassegnare e riprodurre l'audio con l'analisi FFT

Per contrassegnare e riprodurre l'audio con l'analisi FFT:

3. per copiare il grafico FFT negli appunti, 
fare clic su Copia negli appunti (Copy to 
Clipboard). È possibile incollare 
l'immagine in un documento, ma 
facendo nuovamente clic su Copia negli 
appunti, la prima immagine verrà 
sovrascritta. È possibile avere un solo 
elemento per volta negli appunti.

4. Fare clic su Stampa (Print) per stampare 
il grafico dell'Audio FFT.

5. Chiudere la finestra Analisi FFT audio.

6. È possibile continuare a evidenziare 
segmenti del canale AUDIO per 
ascoltare e rivedere i grafici dell' analisi 
FFT fino a qu ando non si preme il 
pulsante FFT.

7. Fare di nuovo clic su          per disattivare 
l'audio e la funzione di analisi audio e 
FFT.

Selezionando il pulsante Analisi FFT, è possibile contrassegnare un segmento del canale AUDIO 
per la riproduzione audio e l'analisi FFT. Il software riprodurrà prima il segmento e in seguito 
visualizzerà l'analisi FFT del segmento in un grafico. È possibile copiare il grafico negli appunti per 
utilizzarlo successivamente o stamparlo.

1. fare clic su          per attivare la funzione audio e FFT

2. fare clic e trascinare il mouse lungo il canale AUDIO per ascoltare quel segmento di dati dopo 
la riproduzione dell'audio, si apre la finestra Analisi audio-FFT

Figura 6.50: Esempio di grafico FFT audio incollato direttamente 
su questa pagina dagli appunti (dimensioni al 90%)
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Figura 6.51: Audio - Schermata Analisi FFT
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Contrassegnare i dati errati

Per informazioni sulla segnalazione assistita, vedere Avvio della segnalazione assistita 
a pagina 6-26.
 

I dati errati non influiscono sul tempo di registrazione totale.

Figura 6.52: Segnale pulsazioni errato contrassegnato come dato errato

Il software contrassegna automaticamente i dati errati durante il download iniziale dei dati da 
MediByte�MediByte Jr. Le forme d'onda SpO2 inferiori al 50% saranno contrassegnate come 
dati errati; anche i dati della frequenza del polso che si verificano nello stesso momento 
saranno contrassegnati come errati.

Quando i dati sono contrassegnati come errati, il segmento viene rimosso dai calcoli statistici 
dal generatore di report, ma questo non influisce sulle statistiche dei tempi di registrazione.

Se il set di dati non ha dati negativi contrassegnati automaticamente perché è stato scaricato 
con una versione precedente del software, è possibile eseguire Segnalazione assistita o 
contrassegnare manualmente i dati errati. Inoltre, è possibile modificare i marcatori di dati 
errati, come richiesto.
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Contrassegnare manualmente i dati errati

Contrassegnare manualmente i segnali SpO2�pulsazioni o tutti i canali come errati usando           , 
il pulsante Contrassegna dati errati (Mark Bad Data).

Per contrassegnare i dati errati:

Allungamento o accorciamento dei marcatori degli eventi dei dati errati

Figura 6.53: Pop-up dati errati

Contrassegnare tutti i canali come errati influirà sul tempo di registrazione 
totale; contrassegnare SpO2/Pulsazioni come errati non influirà sul tempo 
di registrazione totale.

1. fare clic su           per attivare la funzione dati errati.

2. Fare clic e trascinare il mouse lungo il segnale che si desidera 
contrassegnare. Se si trascinano i segnali SpO2 o pulsazioni, un 
pop-up mostrerà Contrassegna SpO2�Pulsazioni come ERRATO 
o contrassegna tutti i canali come ERRATI (Mark SpO2�Pulse 
BAD or Mark All Channels BAD.). Se si trascinano altri segnali, 
si avrà solo l'opzione di contrassegnare tutti i canali.

3. Selezionare se si desidera contrassegnare tutti i canali come 
errati o solo SpO2�Pulsazioni.

4. Fare clic       per disattivare la funzione dati errati.

È possibile modificare la lunghezza di un marcatore di evento di dati errati in qualsiasi 
momento posizionando il puntatore sul bordo sinistro o destro del marcatore degli eventi e 
trascinando il bordo.

Se si contrassegnano tutti i canali come errati, è necessario rieseguire la 
segnalazione assistita per accertarsi che gli eventi associati ai dati errati 
siano completamente rimossi. Deselezionare i dati SpO2/Pulsazioni errati 
nella schermata Segnalazione assistita prima di eseguire la segnalazione 
assistita.
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Per allungare o accorciare un marcatore di dati 
errati:

Figura 6.54: Modifica del marcatore di dati errati

1. andare al periodo�ai periodi con il 
marcatore di dati errati che si desidera 
allungare o accorciare

2. Fare clic su           per attivare la funzione dati 
errati

3. puntare sul bordo destro o sinistro del 
marcatore rosso, sarà visualizzata una 
freccia a due punte [   ].

4. trascinare il bordo per allungare o accorciare 
il marcatore.
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Eliminazione dei marcatori di dati errati
È possibile eliminare tutti i marcatori di dati errati in un set di dati in una sola volta o uno 
alla volta.

Per eliminare tutti i marcatori di dati errati dal set di dati:

Per eliminare un marcatore di dati errati:

1. fare clic su Strumenti>Elimina eventi segnalati 
(Tools>Delete Scored Events) per aprire la schermata 
Rimuovi eventi segnalati (Remove Scored Events)

2. fare clic su Dati SpO2�Pulsazioni errati

3. fare clic su Intero studio (Entire Study) se si vogliono 
eliminare tutti gli eventi, oppure deselezionare Intero studio 
e inserire un intervallo di periodo

4. fare clic su Vai. Una finestra di avviso chiederà di verificare 
se si vogliono eliminare gli eventi segnalati; fare clic su Sì per 
continuare. Quando il programma ha terminato 
l'eliminazione degli eventi segnalati, l'istogramma non 
mostrerà dati errati.

Figura 6.55: Rimuovere tutti i 
marcatori di dati errati

1. andare al periodo (o ai periodi) con il marcatore di dati errati 
che si desidera eliminare.

2. fare clic su           per attivare la funzione dati errati.

3. fare clic con il tasto destro del mouse sul marcatore di dati 
errati e selezionare Rimuovi questo evento.
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e 
Visualizzazione delle statistiche di segnalazione
Puntando il cursore del mouse sul marcatore di un evento di segnalazione, si possono 
visualizzare le statistiche relative all'evento, tra cui:

Per visualizzare le statistiche di segnalazione per un 
marcatore di evento di segnalazione:

Figura 6.56: Statistiche di segnalazione

• etichetta dell'evento di segnalazione: indica il nome abbreviato dell'evento di segnalazione

• unità fisica massima: indica l'unità fisica più alta per l'evento segnalato

• unità fisica minima: indica l'unità fisica più bassa per l'evento segnalato

• intervallo tra le unità fisiche massime e minime: indica la differenza tra le unità fisiche massim
e minime

• durata dell'evento di segnalazione: indica la durata in secondi dell'evento segnalato.

• con il mouse per puntare al marcatore dell'evento di 
segnalazione e saranno visualizzate le statistiche di 
segnalazione.
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Stampa dei report

Per stampare la schermata corrente:

Figura 6.57: Stampa schermata report

È possibile stampare due tipi di report: il report della schermata di stampa e i report generati. 
Il report della schermata di stampa è semplicemente un'immagine dei dati visualizzati sul 
monitor del computer. I report generati utilizzano i dati dell'intero studio per creare un report.

Gli studi devono essere esaminati da una persona qualificata. L'utente deve confermare in 
una finestra di dialogo di aver rivisto lo studio prima di generare un report.

1. fare clic su          e selezionare la stampante da utilizzare per stampare il report.

2. Fare clic su Stampa (Print).



i 
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3. Se è già stato creato un report per questi dati, 
una finestra informativa chiederà se si vuole 
creare un nuovo report o visualizzare quello 
esistente. Se sono state apportate modifiche al 
file di dati, selezionare Crea nuovo (Create 
New); in caso contrario, selezionare Visualizza 
esistente (View Existing). Se si seleziona Crea 
nuovo, una finestra informerà che il sistema sta 
generando il report (come al punto 2) e questa 
operazione può richiedere alcuni minuti. Il 
report viene visualizzato sullo schermo.

4. Dato che il report è stato creato in Microsoft® Word®, se necessario, è possibile apportare 
le modifiche al testo del report.

5. Stampare il report selezionando File>Stampa in Microsoft® Word®.
Stampa di un report generato

Per generare un report completo:

1. Fare clic su            . Si apre la finestra Seleziona un report da creare (Select a Report to Create).

2. Evidenziare il report che si vuole creare e fare clic su Crea (Create). I report disponibili 
dipendono dal tipo di studio registrato. I tipi di report sono:

• report HST (Report sul russamento): un report di una pagina che riporta gli eventi respirator
e di russamento e l'ossimetria registrata durante lo studio. Il report riporta gli eventi 
respiratori per ogni posizione del corpo.

• report SpO2: Un report di una pagina che mostra gli istogrammi della saturazione di 
ossigeno nel sangue per ogni segmento di un'ora nello studio.

• report HSAT 2018: un report di quattro pagine che mostra il riepilogo del sonno, il riepilogo 
delle fasi del sonno, il riepilogo del risveglio, gli eventi respiratori per posizione del corpo e 
fasi del sonno, l'ossimetria, gli eventi respiratori, le statistiche del respiro e l'istogramma. Un
esempio di questo report è riportato alla fine di questo capitolo.

• report CPAP (disponibile solo per gli studi configurati per la CPAP): questo report mostra la 
relazione tra la pressione CPAP e le segnalazioni dell'Indice Apnea Ipopnea e i nadir SpO2.

1. Una casella domande chiede se i risultati 
sono stati rivisti e verificati. Se i risultati sono 
stati rivisti e sono accettabili, fare clic su Sì. 
Se i risultati non sono ancora stati rivisti, fare 
clic su No e rivedere i risultati prima di 
continuare.

2. Se è un nuovo report, sarà generato 
automaticamente.

Nota: Prima di generare il report completo, fare clic su        e 
inserire le informazioni  sul paziente nella finestra Informazioni 
paziente. Accertarsi inoltre di aver inserito un tag Luci spente 
all'inizio dei dati e un tag Luci accese alla fine dei dati.

Dopo aver visualizzato un file di dati, è possibile stampare un report completo. I report 
vengono visualizzati in anteprima e stampati con Microsoft Word®.
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1. Fare clic su            . Si apre la finestra Seleziona un report da creare (Select a Report to Create).

2. Evidenziare il report che si vuole creare e fare clic su Crea (Create). I report disponibili 
dipendono dal tipo di studio registrato. I tipi di report sono:

• report HST (Report sul russamento): un report di una pagina che riporta gli eventi respiratori 
e di russamento e l'ossimetria registrata durante lo studio. Il report riporta gli eventi 
respiratori per ogni posizione del corpo.

• report SpO2: Un report di una pagina che mostra gli istogrammi della saturazione di 
ossigeno nel sangue per ogni segmento di un'ora nello studio.

• report HSAT 2018: un report di quattro pagine che mostra il riepilogo del sonno, il riepilogo 
delle fasi del sonno, il riepilogo del risveglio, gli eventi respiratori per posizione del corpo e 
fasi del sonno, l'ossimetria, gli eventi respiratori, le statistiche del respiro e l'istogramma. Un 
esempio di questo report è riportato alla fine di questo capitolo.

• report CPAP (disponibile solo per gli studi configurati per la CPAP): questo report mostra la 
relazione tra la pressione CPAP e le segnalazioni dell'Indice Apnea Ipopnea e i nadir SpO2.

1. Una casella domande chiede se i risultati 
sono stati rivisti e verificati. Se i risultati sono 
stati rivisti e sono accettabili, fare clic su Sì. 
Se i risultati non sono ancora stati rivisti, fare 
clic su No e rivedere i risultati prima di 
continuare.

2. Se è un nuovo report, sarà generato 
automaticamente.
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3. Se è già stato creato un report per questi dati, 
una finestra informativa chiederà se si vuole 
creare un nuovo report o visualizzare quello 
esistente. Se sono state apportate modifiche al 
file di dati, selezionare Crea nuovo (Create 
New); in caso contrario, selezionare Visualizza 
esistente (View Existing). Se si seleziona Crea 
nuovo, una finestra informerà che il sistema sta 
generando il report (come al punto 2) e questa 
operazione può richiedere alcuni minuti. Il 
report viene visualizzato sullo schermo.

4. Dato che il report è stato creato in Microsoft® Word®, se necessario, è possibile apportare 
le modifiche al testo del report.

5. Stampare il report selezionando File>Stampa in Microsoft® Word®.

Figura 6.58: Finestra di conferma
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Esempio di report MediByte

FASI DEL SONNO 
(tot tempo di riposo)
  6-51



6-52

Revisione dei dati



Revisione dei dati
  6-53



6-54

Revisione dei dati



Capitolo 7: Gestione dei dati

In questo capitolo
Questo capitolo comprende:

• assegnazione delle posizioni di archiviazione

• spostamento�archiviazione dei file degli studi

• decompressione dei file zippati

• spostamento manuale degli studi
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Gestione dei dati
Il software MediByte controlla i nomi dei file e la struttura delle directory per la gestione dei 
dati.

Assegnazione delle posizioni di archiviazione

Per assegnare una posizione di archiviazione

Tutta la gestione dei dati avviene all'interno della finestra Data manager degli studi (Studies 
Data Manager). È possibile utilizzare la finestra Data manager degli studi per eliminare, 
spostare�archiviare i file degli studi in un'altra cartella o masterizzarli su un CD�DVD. Il 
software ha una funzione di compressione dei dati che consente di zippare i dati degli studi 
per risparmiare spazio di archiviazione.

Prima di poter spostare�archiviare i file degli studi, è necessario assegnare una posizione di 
archiviazione utilizzando la finestra Configurazione posizione file (File Location Setup). Il 
software offre quattro possibili posizioni di archiviazione: cartella studi (predefinita), due 
cartelle autoassegnate e CD�DVD.

1. Selezionare Strumenti>Configurazione 
posizione file (Tools>File Location Setup) per 
aprire la finestra Configurazione posizione file.

2. Digitare il nome della cartella in Nome 
(Nome). Questo nome viene utilizzato solo per 
identificare la cartella nella finestra Data 
manager degli studi

3. Andare alla posizione della cartella di 
archiviazione e selezionarla; o digitare il nome 
e la posizione della cartella che si desidera 
creare. Se la cartella non esiste già, una 
finestra pop-up chiederà se si desidera creare 
una nuova cartella.

4. Se si vuole che il software comprima il file 
degli studi, accertarsi che la casella di 
controllo di fianco a Usa compressione zip 
(Use Zip Compression) sia selezionata 
(cerchiata). Dopo essere stato compresso, il 
file non può essere aperto; è necessario 
spostarlo in una posizione di archiviazione non 
compressa, come la cartella Studi e il software 

Figura 7.1: Assegnazione delle posizioni di 
archiviazione. Compressione dei dati selezionata.
lo decomprimerà automaticamente.

5.  Fare clic su Salva.
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7. Se si desidera che i file di studio originali 
siano eliminati dalla cartella di origine, 
accertarsi che sia selezionata la casella di 
controllo Elimina dall'origine quando 
completato (Delete from source when 
complete) (cerchiata nella Figura 7.4).

8. Fare clic su OK  per avviare la funzione di 
spostamento�archiviazione. Se è stata 
selezionata la funzione di compressione zip, il 
software comprimerà i dati e quindi li copierà 
nella cartella selezionata.
Spostamento/Archiviazione dei file 
degli studi

5. Viene visualizzata la finestra Sposta�Archivia 
file. Questa finestra mostra i file che si è 
scelto di spostare e la posizione della 
cartella di archiviazione. Se questa è 
l'impostazione desiderata, fare clic su OK.

6. Se si vuole modificare la posizione della 
cartella di archiviazione, fare clic su       e 
selezionare una nuova posizione della 
cartella. Per fare questo, è necessario avere 
assegnato altre posizioni delle cartelle nella 
finestra Configurazione della posizione dei 
file; consultare Assegnazione di una 
posizione di archiviazione a pagina 7-2. Se 
necessario, è possibile annullare e 
assegnare più posizioni.

Figura 7.4: La finestra Sposta/Archivia file 
mostra i file da spostare e la destinazione

1. Selezionare File>Apri per aprire la finestra 
Gestione dei dati sugli studi.

2. Fare clic sul pulsante       e selezionare la 
posizione di archiviazione dei file. In questo 
caso, la posizione di archiviazione dei file 
selezionata è Cartella studi predefinita. Se si 
vogliono masterizzare i dati su un disco, 
selezionare Unità CD�DVD registrabile.

3. Selezionare gli studi che si vogliono spostare� 
archiviare. Se si vuole spostare�archiviare più 
di un file di studi alla volta, tenere premuto il 
tasto Maiusc mentre si selezionano i file.

4. Fare clic su Sposta�Archivia (Move�Archive) 
per avviare la funzione di spostamento� 
archiviazione.

Figura 7.2: Selezionare la posizione in cui 
spostare i file di prova

Figura 7.3: Tutti i file di prova vengono selezionati 
con il tasto Shift
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5. Viene visualizzata la finestra Sposta�Archivia 
file. Questa finestra mostra i file che si è 
scelto di spostare e la posizione della 
cartella di archiviazione. Se questa è 
l'impostazione desiderata, fare clic su OK.

6. Se si vuole modificare la posizione della 
cartella di archiviazione, fare clic su       e 
selezionare una nuova posizione della 
cartella. Per fare questo, è necessario avere 
assegnato altre posizioni delle cartelle nella 
finestra Configurazione della posizione dei 
file; consultare Assegnazione di una 
posizione di archiviazione a pagina 7-2. Se 
necessario, è possibile annullare e 
assegnare più posizioni.

1. Selezionare File>Apri per aprire la finestra 
Gestione dei dati sugli studi.

2. Fare clic sul pulsante       e selezionare la 
posizione di archiviazione dei file. In questo 
caso, la posizione di archiviazione dei file 
selezionata è Cartella studi predefinita. Se si 
vogliono masterizzare i dati su un disco, 
selezionare Unità CD�DVD registrabile.

3. Selezionare gli studi che si vogliono spostare� 
archiviare. Se si vuole spostare�archiviare più 
di un file di studi alla volta, tenere premuto il 
tasto Maiusc mentre si selezionano i file.

4. Fare clic su Sposta�Archivia (Move�Archive) 
per avviare la funzione di spostamento� 
archiviazione.
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3. Viene visualizzata la finestra Sposta�Archivia 
file (Move�Archive Files). Questa finestra 
mostra il�i file che si è scelto di spostare e la 
posizione della cartella di destinazione. Fare 
clic su      e selezionare la cartella di 
destinazione.

4. Se si vuole che il�i file originale�i siano 
eliminati dalla cartella di origine, accertarsi 
che la casella di controllo Elimina 
dall'originale quando completato (Delete 
from source when complete) sia selezionata 
(cerchiata).

5. Fare clic su OK. Viene visualizzata una 
finestra di copiatura che mostra 
l'avanzamento della copia. Dopo questa 
finestra, verrà visualizzata una finestra di 
decompressione, che mostrerà 
l'avanzamento della decompressione.
7. Se si desidera che i file di studio originali 
siano eliminati dalla cartella di origine, 
accertarsi che sia selezionata la casella di 
controllo Elimina dall'origine quando 
completato (Delete from source when 
complete) (cerchiata nella Figura 7.4).

8. Fare clic su OK  per avviare la funzione di 
spostamento�archiviazione. Se è stata 
selezionata la funzione di compressione zip, il 
software comprimerà i dati e quindi li copierà 
nella cartella selezionata.

Decompressione dei file zippati

Figura 7.6: Selezione di un file compresso da 
spostare e decomprimere

Figura 7.5: I file di prova zippati come appaiono nella 
cartella Archivio

1. Da Data manager degli studi, fare clic su      
e selezionare la cartella dei dati compressi.

2. Fare clic sul�i file da decomprimere e fare clic su 
Sposta�Archivia per avviare la decompressione.



1. Da Data manager degli studi, fare clic su      
e selezionare la cartella dei dati compressi.

2. Fare clic sul�i file da decomprimere e fare clic su 
Sposta�Archivia per avviare la decompressione.

Gestione dei dati
3. Viene visualizzata la finestra Sposta�Archivia 
file (Move�Archive Files). Questa finestra 
mostra il�i file che si è scelto di spostare e la 
posizione della cartella di destinazione. Fare 
clic su      e selezionare la cartella di 
destinazione.

4. Se si vuole che il�i file originale�i siano 
eliminati dalla cartella di origine, accertarsi 
che la casella di controllo Elimina 
dall'originale quando completato (Delete 
from source when complete) sia selezionata 
(cerchiata).

5. Fare clic su OK. Viene visualizzata una 
finestra di copiatura che mostra 
l'avanzamento della copia. Dopo questa 
finestra, verrà visualizzata una finestra di 
decompressione, che mostrerà 
l'avanzamento della decompressione.

Spostamento manuale degli studi
Gli studi si trovano nella seguente directory:

C:�Users�Public Documents�Braebon�MediByte�Studies

Cognome Nome ID paziente

Ad esempio, Michael Jones, che ha un ID paziente 123456, avrà una cartella di studio 
denominata Jones Michael 123456.

Figura 7.7: La finestra Sposta/Archivia file mostra il 
file da spostare e la cartella di destinazione.

Qui si trovano tutti i file e le cartelle associati a uno studio. Le cartelle sono etichettate 
secondo la seguente struttura:

All'interno di ogni cartella, possono essere presenti più cartelle che rappresentano più di uno 
studio per il paziente. Se si vuole spostare manualmente uno studio, è necessario spostare 
l'intera cartella, diversamente si perderanno le informazioni. Si consiglia di utilizzare lo 
strumento di gestione dei file del software MediByte per spostare gli studi.
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Capitolo 8: Password, display e manutenzione

In questo capitolo
In questo capitolo viene descritto come impostare la password dell'amministratore e le 
password degli utenti, come modificare la visualizzazione dei canali e la manutenzione di 
MediByte.

Questo capitolo comprende:

• Password e sicurezza

• Modifica del display

• Pulizia di MediByte

• Manutenzione di MediByte e dei suoi accessori

• Risoluzione dei problemi

• Garanzia
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Password e sicurezza

Modifica della password amministratore

Figura 8.1: Creare una nuova password ADMIN

Il software MediByte utilizza la password iniziale MASTER. Per sicurezza, è possibile aggiungere 
al software una password amministratore e altre cinque password utente.

In caso di difficoltà nell'impostazione delle password, chiamare l'Assistenza 
tecnica al numero 1.888.462.4841.

1. Selezionare Strumenti>Modifica password 
(Tools>Edit Passwords) e inserire la password 
ADMIN (MASTER) per aprire la schermata 
Modifica password.

2. Inserire una nuova password ADMIN. La 
password deve essere composta da 8-10 
caratteri, di cui uno maiuscolo, uno 
minuscolo, un numero e un carattere 
speciale.

3. Fare clic su OK.

4. Reinserire la nuova password ADMIN.



Password, display e manutenzione
Aggiungere utenti e password

1. Selezionare Strumenti>Modifica password e inserire la password ADMIN quando richiesto.

2. Inserire un nuovo nome utente e 
una nuova password. La password 
deve essere composta da almeno 
otto caratteri, di cui uno 
maiuscolo, uno minuscolo, un 
numero e un carattere speciale.

3. Fare clic su OK.

Solo l'amministratore può aggiungere o modificare utenti e password.

È possibile aggiungere fino a cinque utenti univoci al software MediByte. Dopo aver impostato gli 
utenti, il software tiene traccia di tutte le operazioni dell'utente con data, ora, nome dell'utente 
e operazione eseguita nel Registro operazioni utente (User Operation Log).
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Registro operazioni utente

Aprire il registro operazioni utente.

• Fare clic su Strumenti>Visualizza registro operazioni (Tools>View Operation Log) 
e inserire la password ADMIN quando richiesto.

Sullo schermo si apre il Registro delle 
operazioni.

Solo l'amministratore può visualizzare il contenuto non criptato del Registro 
operazioni utente.

Figura 8.2: Inserire la password ADMIN

Figura 8.3: Esempio di registro operazioni

Il Registro operazioni utente è un file di testo crittografato che mostra tutte le attività del 
software. Le voci sono elencate per data, ora, utente e descrizione dell'operazione. Vengono 
registrate tutte le operazioni principali, come l'accesso, l'analisi di uno studio, la generazione di 
un report e la modifica delle password.



Password, display e manutenzione
Modifica del display

Per abilitare la funzione di modifica della forma d'onda

Solo l'Amministratore può attivare la funzione di modifica del display per 
cambiare le forme d'onda. Una volta abilitato, qualsiasi utente può modificare 
la visualizzazione. Accertarsi di disabilitare la funzione di modifica per evitare la 
modifica non autorizzata delle forme d'onda.

L'Amministratore del software può modificare e spostare le forme d'onda. Prima di poter 
modificare le forme d'onda, è necessario attivare la funzione di modifica delle forme d'onda.

1. Selezionare Strumenti>Abilita modifica 
display (Tools>Enable Display Editing) e 
inserire la password ADMIN quando richiesto.

1. Fare clic sulla casella di controllo di fianco alla 
funzione Abilita modifica display della forma 
d'onda (Enable Display Waveform Edit) e fare 
clic su OK.

1. È ora disponibile la funzione di modifica della 
forma d'onda. È possibile disattivare la 
funzione selezionando Strumenti>Disattiva 
modifica display (Tools>Disable Display 
Editing).
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Per modificare le forme d'onda

Figura 8.4: Fare clic e trascinare i bordi superiore e inferiore del display (cerchio rosso).

1. Fare doppio clic con il tasto sinistro del mouse sull'etichetta della forma d'onda. Lo schermo 
cambia colore e si forma una barra sulla forma d'onda.

2. Per spostare la forma d'onda in una nuova posizione, fare clic e trascinare la barra evidenziata.

3. Per aumentare la dimensione della forma d'onda visualizzata, fare clic e trascinare i bordi 
superiore e inferiore del display.



Password, display e manutenzione
Per modificare le proprietà della forma d'onda

1. Fare clic su Modifica, all'estrema destra della barra della forma d'onda, per aprire la finestra 
Visualizza proprietà del canale (Display Channel Properties). Qui è possibile modificare uno 
qualsiasi dei parametri della forma d'onda elencati.

2. Dopo aver modificato le proprietà, fare clic su OK

3. Per cancellare le proprietà di visualizzazione correnti, fare clic su Nuovo

4. Per rimuovere la forma d'onda dal display, fare clic su Rimuovi.

Etichetta Nome sullo schermo di una forma d'onda.

Segnale Nome del segnale raccolto usato come ingresso 
per la forma d'onda.

Posizione

Altezza L'altezza percentuale che la forma d'onda occupa sul 
display.

Superiore�
Inferiore

Intervallo superiore e inferiore della forma d'onda 
espresso in unità.

Inversione I valori superiore e inferiore vengono commutati 
per invertire la forma d'onda sul display.

Digitale

HFF
Il filtro digitale passa-basso, cioè il filtro ad alta 
frequenza, esclude le ampiezze superiori 
all'impostazione del filtro.

LFF
Il filtro digitale passa-alto, cioè il filtro a bassa 
frequenza, esclude le ampiezze inferiori 
all'impostazione del filtro.

Tacca

Scala

Filtro di arresto della banda a 60 Hz o 50 Hz.

Griglia

Figura 8.5: Finestra Visualizzazione 
proprietà del canale

Posizione percentuale del punto medio della forma 
d'onda, dove 0% è la parte superiore del display e 
100% è la parte inferiore del display.

I valori digitali vengono visualizzati periodicamente 
sul display. L'intervallo di visualizzazione dipende 
dalla larghezza del display.

Consente di regolare proporzionalmente i limiti 
superiore e inferiore della forma d'onda per 
migliorarne l'aspetto.

Inserisce linee di griglia tratteggiate sul display 
all'intervallo specificato. Se l'intervallo è impostato 
su zero, sul display viene disegnata solo una griglia 
superiore e inferiore.
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Per disattivare la modifica della forma d'onda

Ripristino del display predefinito
Dopo aver apportato modifiche alle forme d'onda visualizzate, è possibile tornare rapidamente 
alla visualizzazione predefinita. È possibile utilizzare questa funzione solo quando la barra di 
visualizzazione delle modifiche evidenziate è disattivata.

Per ripristinare il display

1. Fare clic su Strumenti>Ripristina display predefinito (Tools>Reset to Default Display) e il 
display tornerà alle impostazioni di fabbrica.

1. Selezionare Strumenti>Disabilita modifica 
display (Tools>Disable Display Editing) e 
inserire la password ADMIN quando 
richiesto.

2. Fare clic sulla casella di controllo di fianco 
alla funzione Abilita modifica della forma 
d'onda del display e fare clic su OK.

3. Facendo clic su un punto qualsiasi dello 
schermo, la barra di modifica evidenziata sul 
display scomparirà.



Password, display e manutenzione
Pulizia di MediByte

MediByte è un dispositivo non sterile che non entra in contatto con il paziente.

Consigliate:

Per pulire MediByte:

1. pulire delicatamente MediByte con un panno disinfettante, un panno con alcool isopropilico 
o un panno umido.

2. Accertarsi che MediByte sia completamente asciutto prima dell'uso.

Per pulire la scatola elettrodi e il cavo di comunicazione:

1. Marchio registrato di Sono.

NON è necessario sterilizzare MediByte. NON sterilizzare MediByte in autoclave 
a vapore, per evitare di danneggiarlo e invalidare la garanzia.
NON immergere MediByte nei liquidi per non danneggiarlo. I danni provocati 
dall'acqua annullano la garanzia.

• Salviette disinfettanti come Sono® Wipes1 o Sani-Cloth® Wipes2, che utilizzano 
ammonio quaternario (cloruro di dimetil ammonio).

• Alcool isopropilico.

• Panno umido.

Per ulteriori informazioni, consultare le linee guida dell'Association for Professionals in 
Infection Control and Epidemiology (APIC) per la selezione e l'uso dei disinfettanti 
(American Journal of Infection Control. Vol. 18, n. 2, aprile 1990).

1. pulire delicatamente la scatola elettrodi e il cavo di comunicazione con un panno 
disinfettante, un panno con alcool isopropilico o un panno umido.

2. Accertarsi che la scatola elettrodi e il cavo di comunicazione siano completamente asciutti 
prima dell'uso.
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Manutenzione di MediByte e Accessori

• MediByte non richiede alcuna manutenzione.

• MediByte non richiede alcuna calibrazione.

Smaltimento delle batterie

NON utilizzare o tentare di riparare parti danneggiate.

L'apertura non autorizzata di MediByte invalida sia la sicurezza di MediByte, sia i 
termini e le condizioni della garanzia MediByte.

MediByte può essere riparato solo da personale specializzato BRAEBON. L'apertura di MediByte 
da parte di persone non autorizzate invalida sia la sicurezza di MediByte, sia i termini e le 
condizioni della garanzia MediByte.

Se MediByte o uno dei suoi accessori sono danneggiati, contattare immediatamente BRAEBON 
al numero 1.888.462.4841.

Smaltire le batterie usate in modo responsabile. Per trovare un punto di smaltimento delle 
batterie vicino, visitare il sito www.ehso.com.
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Risoluzione dei problemi
In caso di difficoltà nell'utilizzo del prodotto, verificare quanto segue:

Problema Soluzione

Segnali scarsi

MediByte smette di 
raccogliere dati 
prematuramente

Impossibile recuperare 
i dati da MediByte

MediByte è stato 
immerso in un liquido

Nessuna 
comunicazione 
tra il computer e 
MediByte

• Accertarsi che la batteria sia inserita in MediByte.
• Sostituire la batteria.
• Verificare che il cavo USB di MediByte sia collegato a MediByte e al 

computer.
• Riavviare il computer e dopo il riavvio, inserire il cavo USB in una porta USB 

disponibile e quindi collegare l'altra estremità del cavo in MediByte.
• Reinstallare MediByte Software.

• Verificare che tutti i sensori e gli elettrodi siano stati collegati correttamente a 
MediByte e che tutti i sensori siano stati applicati correttamente al paziente. 
Poiché MediByte non mostra la raccolta dei dati in tempo reale, non è 
possibile verificare il posizionamento dei sensori mentre il paziente è 
collegato all'unità. È necessario accertarsi che il paziente comprenda il 
corretto posizionamento dei sensori prima di lasciare la sede.

• La memoria è piena, recuperare i dati da MediByte e riprogrammare l'unità.
• Sostituire la batteria al litio standard 1/2 AA.

• Verificare la comunicazione tra il computer e MediByte. Consultare 
"Nessuna comunicazione tra il computer e MediByte", sopra.

• Contattare BRAEBON Medical Corporation al numero 1.888.462.4841 o al 
numero 1.888.462.4844. Al momento della chiamata, tenere a disposizione 
il modello e il numero di serie del prodotto.

Si si riscontrano ancora problemi con il prodotto, contattare l'assistenza tecnica al numero 
di telefono 1.888.462.4841 o via e-mail all'indirizzo support@braebon.com. Visitare il sito 
web per trovare le risposte alle Domande frequenti (FAQ): www.braebon.com.
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Garanzia

Avvertenza: L'apertura non autorizzata di MediByte invalida la sua sicurezza e iMe
termini e le condizioni della garanzia MediByte.

Precauzioni: Il mancato utilizzo del tipo di batteria corretto, come indicato nel 
presente Manuale d'uso, invalida la garanzia.

Le specifiche sono soggette a modifiche senza preavviso.

BRAEBON MEDICAL CORPORATION garantisce al primo consumatore che questo MediByte, quando viene spedito nella sua 
confezione originale, sarà privo di difetti di fabbricazione, o relativi alle prestazioni e ai materiali e si impegna a riparare a 
sua discrezione, il difetto o a sostituire il MediByte difettoso o una sua parte senza alcun addebito per l'acquirente 
relativo alle parti o alla manodopera per un periodo di un anno dalla data di acquisto. La garanzia qui descritta sarà 
l'unica ed esclusiva garanzia concessa da BRAEBON MEDICAL CORPORATION e sarà l'unico ed esclusivo mezzo a 
disposizione dell'acquirente. L'uso di MediByte costituisce l'accettazione totale e completa della presente garanzia. La 
correzione di difetti, in base alle modalità e ai tempi qui descritti, costituirà il completo adempimento di tutte le 
responsabilità di BRAEBON MEDICAL CORPORATION nei confronti dell'acquirente in relazione a MediByte e costituirà la piena 
risposta a tutti i reclami, basati sul contratto, sull'inadempienza, sulla responsabilità oggettiva o altro. In nessun caso 
BRAEBON MEDICAL CORPORATION sarà passibile o in qualsiasi modo responsabile di qualsiasi perdita di ricavi o danni, 
diretti, indiretti o consequenziali, compresi danni alla proprietà, perdita di guadagno, o danni personali derivanti dall'uso o 
dall'uso improprio o dall'incapacità di utilizzare questo prodotto. E BRAEBON MEDICAL CORPORATION non sarà passibile o in 
qualsiasi modo responsabile di qualsiasi danno o difetto di MediByte che sia stato causato da uso improprio, inadeguato, 
manomissione, negligenza, tipo di batteria inadeguata o riparazioni o tentativi di riparazione da parte di persone diverse 
da quelle autorizzate alla riparazione. La presente garanzia copre esclusivamente i modelli MediByte MP-8 e MBJR. Gli 
accessori e i materiali di consumo hanno garanzie separate con periodi di copertura diversi.
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